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1. Introduction

This user manual will take you through the relevant steps so that you will be able to operate your iMiniPlus product.

The chapters in this manual are placed in an order that you will need to follow in order to successfully use the iMiniPlus for
the first time.

This manual covers all the features included in the current version of the ConsolePro software. Therefore, if you find a
feature described within this manual that does not appear in your software and/or a feature within the version of software
being used that is not described in this guide, then we recommend you obtain a newer version of the software and/or a
newer version of this guide

Software Version
v2.12.07

Note: This User Manual is to be used with the above version software (or later) only. If you are using ConsolePro software

version earlier than the above, the content, instruction and features described herein may not be the same. Contact Cryopak
Verification Technologies, Inc. or your nearest distributor for appropriate software and user manual.

2. iMiniPlus Profile

iMiniPlus Models

The iMiniPlus is available in three models.

D range MP-ST-D-8-L | Internal sensor Single use -LO°C to +70°C
MP-IN-D-8-L Internal sensor Multi use -LO°C to +70°C
MP-OE-D-8-L | External sensor Multi use -LO°C to +70°C

N range (Dry Ice) MP-ST-N-8-L External sensor Single use -100°C to +40°C
MP-OE-N-8-L External sensor Multi use -100°C to +40°C

Internal sensor model has the sensor mounted inside the logger but externalized to the air to allow free movement of air
media across the thermistor head (Model MP-IN-D-8-L)

The other model comes with the same sensor as above but encapsulated inside a stainless steel tip on a Tmeter PVC cable.
This sensor assembly is permanently connected to the body of the iMiniPlus (Model MP-OE-D-8-L/ MP-OE-N-8-L / MP-
ST-N-8-L)

The iMiniPlus has a fully functional LCD display and keypad. A summary of these features and functions are summarised
below.

iMiniPlus Images
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MP-OE-D-8-L

External sensor
For D range

HIGH ALARM
LOW ALARM
alarm has been triggered

LATEST - Displays the
last logged temperature
MARKED - Bookmark
activation

START Button
start, mark and scroll
functions

MP-OE-N-8-L / MP-OE-N-8-L

DRY ICE TEMPERATURE LOGGER

iMiniPlus

External sensor
For Dry Ice logger

MP-ST-D-8-L
MP-IN-D-8-L

Attachment lug
For fixing to item or wall

Low Battery Icon

www.escortdataloggers.com

Temperature
Latest, Highest, Lowest or
Average

HIGHEST LOWEST
AVERAGE
Displays the high, low and
average recording

STOP Button
Hold for 3 seconds.

Temperature sensor
Is here
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e 2 W memime. =
Serial Number: MH-BI-164-011
Product Code:  MP-IN-D-8-L

0

RS232 connection

Identification sticker
with barcode

Battery cover

The iMiniPlus comes with water-proof covers for the RS232 connection and the battery.

Make sure that when logger is in use these covers are in place. This is important in wet or dusty environments. If covers are
lost please contact your distributor for a replacement.

3. Installing the Software & USB driver

To operate your iMiniPlus logger you will need to first install the software on your computer. This will allow you to prepare
your iMiniPlus for use, retrieve the readings the iMiniPlus has recorded, and analyse the data. This chapter will take you
through the steps necessary to successful install the software on to your computer so you can begin using your iMiniPlus.

System requirements

To ensure that the software will be able work with your computer, the following lists the minimum specifications required:

Minimum requirements:
Pentium Il 233MHz processor
6L4MB RAM
15MB free disk space

Windows 98, Windows Me, Windows NT, Windows 2000, Windows XP

Internet Explorer 5.0 or later
1 available USB port
800 x 600 screen resolution
256 screen colours.

The recommended specifications are:

Windows 2000, Windows XP, Windows Vista, Windows 7, 8, 8.1 or Windows 10

Internet Explorer 6.0 or later

65535 (16bit), or more, screen colours.
1024 x 7638, or higher, screen resolution.



Getting a copy of the ConsolePro software

The software is available on CD from your distributor or downloadable from www.cryopak.com site, Data Logging Systems
does not charge for the on-line download of the ConsolePro software or for the updates to the ConsolePro software.
Install the free Console Pro Software using either

1. The Console Pro Software CD or

2. Through the CRYOAPK website www.cryopak.com

3. http://www.cryopak.com/files/1613/7599 /1145 /econsole_21207pro.zip
L. See instructions below for Website Installation

Contact Login Sign Up Blog ®

COLD CHAIN  VERIFICATION CrVOpako

PACKAGING SOLUTIONS
a TCP Company

CRYOPAK
SUSTAINABILITY

COLD CHAIN DATA LOGGERS & REGULATORY
PACKAGING MONITORING TESTING CENTER COMPLIANCE INDUSTRIES RESOURCES

Home / Data Loggers 8

Data Loggers and Monitoring Products

Data Loggers

. o}
Temperature Indicators The Cryopak Verification Technologies business
unit is committed to the design and manufacture r o a
Real Time Monitoring

of the most technically advanced, reliable, self Verification Technologies
Distributars powered data loggers in the world. We employ ({2 a Tep company

the latest technology as it becomes available
Return and Refurbish and have a strong track record for introducing new products to meet customer needs. We pride

ourselves on being a market driven company providing a high level of service to both distributors
Software Downloads ] and customers alike.

Dedicated to provide quality management solutions that offer an extensive range of temperature
CLICK HERE TO > and humidity data loggers. Cryopak data loggers are principally used for Cold Chain Monitoring
REQUEST A QUOTE and Cold Chain Visibility to ensure Food, Medical and Pharmaceutical products are stored and
transported in correct temperature conditions. Temperature monitoring and humidity data loggers
are extensively used for environmental and heating and ventilation monitoring for building

management plus energy saving applications.




iMiniPlus Profile 9

Contact Login SignUp Blog @

o]
COLD CHAIN VERIFICATION Cryopak CRYOPAK CRYOPAK
PACKAGING SOLUTIONS CANADA SUSTAINABILITY
aTCP Company

ABOUT S s e TESTING CENTER imtal INDUSTRIES RESOURCES

PACKAGING MONITORING COMPLIANCE

Home ' Data Loggers & Monitoring - Software Downloads

Data Logger Software

Cryopak currently offers two different software packages. Console Plus is the most recent version which was released in late
2012 and has improved features making it easier to use and more accessible.

« Internet-based software to download and share temperature/RH data on a secure, third-party web site (cloud) with
designated partners, leading to improved relationships and collaboration.

* Lets you manage, sort, and query large amounts of data.

e Easy sharing of partner access — any time, any where.

* Enter shipment notes, easy email of reports and graphs.

« Easy programming and downloading of Cryopak data loggers

* Automatic updates each time you login.

Console Pro in the predecessor model of software that still operates our legacy Escort products including the iLog.

Console Plus Console Pro
Download this software to run the following products/ranges: Download this software to run the following products/ranges:
« Intelligent Mini e Junior (EJ Range)
(MI Range) e Wireless REDiI
« iMINI Temperature (MX Series) . !MI.HIIP|US (MP Range)  Wireless Intelligent Mini
) L ) * iMiniPlus PDF e Chart Reader
¢ iMINI Temperature & Humidity (MX Series) (MU Range) (EA. E, EJ Range)
e iMINI USB PDF (MS Series} « iLog (El Range) « Beer Logger (HJ-FP-U Range)
* Precision e High Temp Junior
(EX & EH Range) {HJ & HT Range)
*This is a free download click the download button to *This is a free download click the download button to
download the file and then unzip and install download the file and then unzip and install
# Download Download
Free Software Free Software

5. Once you have downloaded and installed the Console Pro Software, move on to the second phase of installation by
installing the USB Drivers.

For a more in depth guide to Console Po Installation, please refer to the user manual provided on the website:
www.cryopak.com




10

File Download - Security Warning 37% of econsole_20709pro.exe from www.e.... [= | C1/[5] [l Download complete EE&X
Do pou want to run or zave this file? ~ &
g 4  Download Complete
ﬁ MName: econsale_20709pr0.exe
Typec Applcation, 13.6M8
Front www.escorbds.com econsoke_20709pro.exe from wwe.escortdls. com econsole_2070%pro.exe from waww. escorkdis,com
: ) (Feanannnnnnannns )| (RN SRR SRR N AN RARAA AN RRN AN RS AR RSN ]
Estimated time left 2 min 25 sec (4.93MB of 13.6MB copied) Downloaded: 13.6ME in 3 min 31 sec
I Fun | <r Save D [ coee | Download to: C:\Docume. . |econsole_20709pro,exe Download to: CH\Docume. . \econsole_20709pr0.exe
Transfer rabe: 61.4KBf5ec Transfer rate: £5,1KB/Sec
[ Close this dialog box when download completes [T Close this dialog box when download completes
I@ ‘while files from the Intemet can fbe usefud, this fle ype can
potentialy harm pour computer. IF you do not ust the source, do not
fun o6 save this soltware. what's the gk = en Folde | FRun || OpenFolder | | Cloze |

We recommend choosing the option to save the file and to save the file to your desktop. If you are an experienced user, you
may wish to save the file to a different folder of your choosing. Once the installation process has been completed, this file
can be safely deleted, as it is not required for using the software.

At the conclusion of the installation process, the final screen will provide you with an option to immediately start the
ConsolePro software.

The installation of the ConsolePro software will also provide you with two simple methods to start the ConsolePro at a later

time:

e A "Shortcut” on the desktop, which you can double click to start the software.

e A "Shortcut” in the "Start” menu system. If you are using Windows XP for example, you may need to click on the "All
Programs” item to locate the "Console" shortcut.

Installing the USB adaptor cable drivers

To be able to operate the iMiniPlus with ConsolePro Cryo
Software, you have to connect the iMiniPlus to your
computer with a serial to USB or serial to serial adaptor.
A USB cable requires driver software for it to be used.
This software is supplied on mini CD format with the
adaptor or from web site www.cryopak.com

vrrmc mon !ocl-whquu\-

e Insert the driver mini CD into your computer CD
ROM and the following screen box will be
displayed. Select Auto Install

Drivers for EA-INT_USB and JA-USB-SER v. 3.0

Dnvers for EA-INT-USB & JA-USB-SER

Installation guides.

User guides for manual netalatons.
i e = e  Select Run.
s 2000 e  Select Next.

- e  Select Finish. Reboot your PC

Upen Fibe - Seamty Warmmg E xj

Do o waed b s s ke

D Mame VP Dewer Inetler gxe
Futlaber: Excod Ouis Lougien Seslums Lisfied

i Findews Vaia . . Apcheabor
: and insert the USB cable. If this does T T HYOTM NS e D
- not work, you will have to |ns’FaII using w |CEEd
. the “Found New Hardware Wizard” on
‘Escon-r your computer Control Panel. See 0] ,%'«:f%',%?f“":”“* Sevddumecn .

e gl iy next sections.
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Virtual COM Port Driver Installer Virtwal COH Port Driver Instalicr l 8 [ virtunl CORt Port Driver InstaBier L

Inatalling the softwars for your FTDI device..
Welcome to the Virtual COM Port

Driver Installer!

T =y Y i
2 'Eu - This wizard vl install ¥irtual COM Pert diivers for your FTDI ‘Eﬂ e
USE device.
] ) Tre drvsm ware sucosaduly natalad onthie computar.

X i_";// ,v_:af You 20 oo pamedt yaur devce tothis compLter. Fyour device

‘zama with netructions, pleses read them firs.

Congratulations! You have finished
installing your FTDI device.

e 7

L L

Plees weit whie e dhivers inst=l. This mey bakos sore bme fo complet=

Drver Heme [ otz
 FTD COM Driver Packs.. Readytouse
N FT0 COM Drver Packa... Aeadytoues

To continue, click Mest

<Balc spep || Mt cp e |

Getting a copy of the USB drivers from the web
. . . . i . USB Driver for Windows
If you misplace the driver mini CD, you can obtain the driver files from our web . _ . . o
. ou will be notified by your distributor via email as
site WWW.Cryopak.Com each new version of this software is available. You wil
http: / / www.cryopak.com/temperature-monitors /software-downloads / E:Z”at”:e“ fo re-visit this page to download the
Here you can

& DOWNLOAD 64 BIT DRIVER
On the Software Download page, you will see a list of driver file USB driver for
windows. Download the appropriate driver file for your Windows operating system
and save to your desktop. Please note the file is in ZIP (compressed) format.
Select save.

Do you want to open or save this file?

. DOWNLOAD 32 BIT DRIVER

@ Mame: win xp_2003_vista_x64.zip
Type: Compressed (zipped) Folder, 603KE Saveir | [} Desktop H O 2 -
Fram: v escortdls, com Select Desktop = ﬁMyHecenan:uments
L {3 My Documents
[ open J[ save | [ Concal | My Rcent 8 My Computer
Documents 3 34 Floppy (8)

G [BM_PRELOAD (C:)
i DVD/CD-RYW Diive (D:)
e Removable Disk (E:]
5 ACT on workstation T an “workstation? [wior
(5 Shared Documents
(6 Admir's Documents
- (5 Fred's Documerts

My Documents ) by Documents
{8 My Sharing Folders

E 2 Nokia Phone Browser

5 &3 My Network Places
My Computer I DSE Driver

Always ask befare opening this tpe of file

=
[

Desktop

l““ 1 While: files from the Intemet can be useful, some files can potentially
@ harm your computer. |f you do not tiust the source, do ot open or

save this fils, What's the risk?

Download complete

ET [ ECorsols_2 07_09 (D)
W D
e Download Complete -
= A Select close -'; File name: | in 2000_sp_2003_vists v [ s |
B :
MyMetwork | Ssveastps | Winip File v [ Concel |

W MR202000_xp_ 2003 _viska,zip from www,escortdls, com
[
Dowrloaded: 371KB in 2 sec

Download to: Do, win 2000 _xp_2003_vista.zip
Transfer rate: 185KEfSec

[ Close this dialog box when download complates

63

[ Open ] [ Open Folder ] [ Close ]

Because the file is in compressed (ZIP) format, you will have to extract it into another 3.1
folder. The file icon on your desktop may look like one of these: win 2000_xp_2003_vista.zip
Double click on the ZIP icon and extract all the files into a new folder and name it USB E

Drivers. Once the files are extracted you can delete the original ZIP file if you like. . . .
win xp_2003_vista_x64.zip
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Installing USB Driver Files using Found New Hardware Wizard

If you have experienced a problem installing your USB drivers using the original instructions, you can install either the mini
CD or the extracted ZIP file you have downloaded as detailed in the previous chapter, via the “Found New Hardware Wizard”
in your computer Control Panel.

In some events if the driver is unable to install, user may require to extract the *.exe file with winrar software in a folder and
by browsing the device driver update wizard to the that folder

Note: User must have ADMIN rights to install driver and Console Pro software

Installing ConsolePro Software

Note: User must have ADMIN rights to install driver and Console Pro software econsole 21207pro
To install the ConsolePro software, first you need to locate the installation file that was i1 Escort Console for Windows
downloaded from the Cryopak website or from CD received when purchased. , T Bata koguensdnc:

To begin the installation process, open the installation file, which is typically Open File - Security Warning X
performed by double clicking the left mouse button. The installation process will Do S

guide you through the relevant steps to correctly and successfully install the Name:

software. If you have installed any other software, you should find the installation Publisher. Escort Data Loqaing Svstems Limited
process familiar. To proceed through each step of the installation process, click the Lﬁ mmwsamm&hhmmp

"Next" button. If you want to change a previous step you can click the "Back”
button. When the process is ready to be completed, clicking the "Finish” button,
when it appears, will finish the installation process. If you want to stop installing the

software, click the "Cancel” button. Wthie e fom the It can be useful, s fle ype c2n
@ potentialy haim pour computer. Only run software from publshers
you trust. What's the risk?

[7] Adways ask before opening tis fle

=4 Escort Console - InstallShield Wizard

Extracting Files
The contenis of this package are being extracted, "~

Pleass wait while the InstalShield Wizard extracks the les neaded to instal Escart
Cangole on your camputer, This may take a few moments.

Extracting [e0E09. ... InstallShield Wizard

Choose Setup Language _' J Escait Conzole Setup iz prepaning the Installs hisld 'wizard, which
— wil guide you thiough the program setup process. Please wail

Configuiing Windaws Instalier

I CLLLCICLI LI O I
Englizh [United States)
Bl
Escort Console - InstallShield Wizard [Z| Escort Console - InstallShield Wizard

License Agreement ; “

Welcome to the InstallShield Wizard for Escart Fleaze read the following kcense agreement canehully.

Console
Frezz the PAGE DOWH key to ses the rect of the agieemsnt.
The Irestalls hield® 'wizard wil inztall Escort Conole on
your computer, To conlinue, chck Next

SOFTWARE END USER LICEMSE AGREEMENT A

IMPORTANT
THIS IS A CONTRACT BETWEEN '¥DU AND ESCORT DATA LOGGING SvYSTEMS
LTD. PLEASE READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY
BEFORE INSTALLING DR USING THIS SOFTWARE. BY DPEMING THE SOFTWARE
PACKAGE AND/OR INSTALLING THE SOFTWARE, YOU ACKNOWLEDGE THAT

0U HAYE READ AND UNDERSTOOD THIS LICENSE AGREEMENT AND AGREE
T0 BE BOUND EY ITS TERMS AMD CONDITIONS. IF YOU DO NOT ACCEPT THE

Do you accept al the terms of the preceding License Ageement? IF pou Biinit
sefect Mo, the setup wil cloze. To install Escot Conzobe, you must accept
this agresment,

Carcel ¢ Back Yes [
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Escort Console - InstallShield Wizard

Customer Information

Escort Console - InstallShield Wizard rz" Pleass enter your information
Information A LY ‘
Please read the following text. 4 Uzer Name:
s |.John
LCompary Narne:
[Gmith . C

E zcort Conzole will disable all versions of Escort for Windows apart from
version 1.62.01 or later, If you still want to use the Escort for ‘Windows
software after installing Escort Console, you will need o install E scort . : .
for Windows version 1.62.01 or later, which s avalable fies cn the e Rbez e
intemnet at www.escortdls.com/software, Altematively, if you were supplied .
this software on COROM, you will ind 2 copy of the appropriste version of %" Anypone who uses this computer (all users)
Escort for Windows on the COROM. € O for me Wobel

Fieaze note that § you configure Escort Console o access a user database

crealed by the Lser Admin Package, any exdsting instalation of Esco for
findawes will ically be dizabled in order to comply with the security

Tequ of US FDA& Title 21 CFR Pait 11.

< Back Heut > Cancel

<Back [ New> | Cancel |

Escort Console - InstallShield Wizard | Escort Console - InstallShield Wizard Note: This
Choose the features and languages Setup will install "-‘ Choose Location of the User Accounts Database k1 ‘ section
Select folder whese Setup wil find the database cortaining the user . rela‘te.s e
atcounts. , additional
) . A | software
Select the features and languages you want to install, clear the choices pou do not wark to Please enter the location where the database containing the uses accounts for the Escort called “User
install Console softwars reside. Admin”
| German [T ‘r'ou may leave this field blank if pou do not wank to connect to and/or use a User Accounts which is
alian oK Database. s
Engiish (UK Please note; designed @
4 Enghsh LK) 1. Tocreate a User dccounts Database you require the ESCORT User Administratos comely
¥ Engish [LIS) 1388k " Package, which is avalable fror your distibutor. CFR 21 Part
1 Spanich 0Ok 11
Palish 0K 2. I you purchased a Console Professional Software licence far this computer, providing a specification.
Destination Folder I\;;;I::;:;uﬁlzzﬂ allow pou and other users of this installation to add digital signatures to ijg:; ;;;‘5 not
C:\Program Files\E scort DLSA\E scort Console'. | software
Space Required on [ 504 K Disk 5 5:::;:”5
Space Available on C: 5056124 K ﬁl ey select Next.
< Back Hest > | Cancel | < Back Hext» Cancel |

Escort Console - InstallShield Wizard
Setup Status

Escort Console - InstallShield Wizard

InstallShield Wizard Complete

Setup has inished ingtaling Escot Console on pour computer.
Escoit Console is configuiing wour new software installation. phash 9 ’ "

¥ Launch the Escort Conzole software.

Creating shortcuts

O e

At the conclusion of the installation process, the final screen will provide you with an option to immediately start the
ConsolePro software. The installation of the ConsolePro software will also provide you with two simple methods to start the
ConsolePro at a later time, which are a "Shortcut” on the desktop, which you can double click to start the software and a
"Shortcut” in the "Start” menu system. If you are using Windows XP for example, you may need to click on the "All
Programs” item to locate the "Console"” shortcut.

4. Quick Start Guide

Now you have the software and drivers installed on your computer, you can start to use the iMiniPlus. This chapter will
briefly cover the steps involved to get your iMiniPlus ready to use, how to get it started and then retrieve the recorded
information. The subsequent chapters will explain in more depth these steps and the various options available to you.
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Connecting the serial or USB cable to PC

The connectors for the serial (RS232) communications ports typically look like
the following picture. -

Serial (RS232) communication ports can be typically
found at the rear of the computer. Most serial
connectors will have screws included on the plug and
we recommend that these are tightened when the
connector is plugged in so that it does not accidentally
pull out during use.

Some of the more common USB connectors are
pictured below.

Connectors for USB devices and the sockets on the computer where USB devices are plugged in will often display a USB logo
nearby to help them be identified.
The sockets for the USB communication ports are typically located at the rear of the computer. In some computers there may
also be two or more USB communication ports located on a front panel of the computer and/or on the top of the computer
case. Please ensure that the driver software has been installed prior to connecting the USB cable.
If the computer is using the Windows NT® operating system, a USB cable will not be able to be used, as Windows NT® does
not support USB devices.
Important notes:

e Ensure to select manual the COM port before download and program the unit

e If using USB to serial adaptor the COM port # will be COM3 or higher

e If using Serial to serial interface the COM port # will be either COM1 or COM2

Connecting the serial or USB cable to the iMiniPlus

The iMiniPlus has a serial DB9 connection on the rear. Connect either the serial cable or
USB cable DB9 male connector to this. Make sure that the connector is pushed in, making
the connection tight and not loose.

RS232 DB9 connection

N ce E ¥ i W
Serial Number: MH-BI-164-011

| Product Code;  MP-N-D-8-L
S (CH A
Requires Consoie 207,08 of dhove.
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Launching the software

The installation of the ConsolePro software provides you with two simple methods to start the Console:

1. A "Shortcut” on the desktop, which you can double click to start the software.

2. A "Shortcut” in the "Start” menu system.

+

¢y
ESCORT
e’

Escort Console

If you are using Windows XP for example, you may need to click on the "All Programs” item

to locate the "Console" shortcut, like in the following picture.

3. To program the iMiniPlus to record information,

Launch the ConsolePro software from the desktop or All Programs menu.

The software will open and display the following screen:

_ File Edit Action Help

EHE=oap 2Q AZAU AEN
N[z Manager - %]
Byviews | iris | @anayss |
& &= Readings

[E Lt of readings

[& Readings and summary
-l 20 Graph

B= e

B Step
=-EF Summary
EE Overview
E Statistics
E Analysis
[ Out Of Specification
[E Marked Readings

N [Pert =nd Produce =

[ 7 Communications Port (COM1]
¥ 9 Communications Pert [COM3)

| n d

¥ ESCORT iLog/Qualaire

163 ESCORT Precision

1 ESCORT ChartRieader

(1€ ESCORT Jurnior

18 ESCORT Mini 2000/ nteligent ChartFleader
CIFMESCORT Mini 2000

CIF) ESCORT Inteligentwireless Miri

(1B ESCORT RED

3

I ESCORT MinPlus -
([ Pre——p—
For Help, press FL NUM y

From the menu, select Edit, then Options

Products I Communications I Languages | Colars I Advanced I ‘
General | File I Date l Time | Time Zone I ZDGraphs I Legend

Display temperatures in

Dialog Texture ISlandar\:I
¥ Display the Status Bar

¥ Display the View Manager

¥ Display Ports and Products

T~ Display Tip of the Day when starting

Select the
Products Tab

W'® Defauit Programs

o~ Adabe Acrobat X1 Pro Parminder Singh

|# Adobe FormsCentral
@ Citrix Receiver Jocuments

@ Desktop Gadget Gallery
Excel 2016

& ImgBurn

{2 Internet Explorer

@ Moxilla Firefox

#& OneDrive for Business
[ Onehote 2016

[ Outlook 2016

[ PowerPoint 2016

@ Publisher 2016

(@) Skype for Business 2016
B TeamvViewer11

&4 Windows DVD Maker
4 Windows Fax and Scan
 Windows Media Center
[ Windows Media Player
& Windows Update

B word 2016

<A XPS Viewer

| Accessories

L Canon

b Clover

L CopyFilenames

A Escort

& Escot Console
. Escort DLS
@ ConsolePlus
™ Uninstalt ConsolePlus
1 ESET
L. File Renamer Pro
)i Foxit PDF Editor
L. Foit Reader
1. Games
). Image Resizer for Windows

4 Back

General | Fle | Date | Tme | TimeZone | 2D Graphs | Legend |
Products i Communications I Languages I Colors I Advanced

] &3 ESCORT Precision
[] €% ESCORT Jurior
CIFMESCORT Mini 2000

1B ESCORT REDi
W[ ESCORT iMiniPlus

BT iLog/Qualsire
[} ESCORT ChartReader
D@ ESCORT Mini 2000/ Inteligent ChartReader

CIFESCORT inteligent/Wirsless Mini

In the Products tab you will see a list of all the products supported by the ConsolePro Software. Make sure the “iMiniPlus”
box is ticked and click on OK or Apply. If you intend to use other products, you may tick as many of the boxes you require.
Next make sure you have selected the correct Communications Port. Note that the USB cable needs to be connected to the
PC before you start the ConsolePro Software otherwise it won’t show on the list below. Click on OK or Apply.
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Both the Products and Communications Ports can be selected through the Ports
and Products just below the View Manager on the left hand side of the initial
software page.

Next click on the Program and Configure icon that is located on the toolbar.

File Edit Action Help

a8leut aew

FHdéEda | 6B R

The Program and Configuration Wizard finds the communication port that the
iMiniPlus is connected to enable it to be setup for use.

‘Welcome to the ESCORT program and configuration wizard.
Thiz wizard will guide pou through the program and configuration process
ol ESCORT products. Please click Mext when vou are ready ta proceed.

If your software

is unable to
Ready | Search] locate a logger
This will retrieve information from loggers and/or ChatR eaders thiough the: communication port(s] to d ue to
allows vou to conligure the warious settings.
Please ensure all loggers are in an interface and/or ChatReaders are also connected ta the commun |Cat|0n
communication portfs] of this computer.
problems the
Press Mest when ready to procesd .
following

message will
be displayed.

—

I Do not remind me of this again

Options.

I Date l Time: I Time Zone i 2D Graphs I Legend |
I Languages I Colors I Advanced

General | File

Products Communications

Communications Port (COMT) unavailzble (Eror 5)
v r,L;Cnmm\_\nlc:at\mﬂs Port {COM3)

The communication ports are now being checked for ESCORT products
*You can select the ESCORT products that you want to program and
configure by putting a check in the box next to the entry. You may click.
Mest when you are ready to continue

The softweare was unable ta locate any products that it supports on the enabled communication ports.

Press the "Search' button below when you are ready to iy again,
Alternatively, you can press the 'Cancel” button to check youwr settings in Edit/0ptions menu.

_ Ready Search

Please check the following:

*'our product may require battery replacement or recharging.
*Right COM port number iz enabled in Edit/Options menu.
*Interface cable is secuely connected to the COM port,
*Logger is securely connected to the respective interface.

| ¢Back I Mext > I Help |

Cancel | 1€ Re

1 i 1 sean |
Cancel | \<F|estan| < Back | Pt > l Help |

Check that all four bullet points displayed in this message are attended to. Once rectified either close the ConsolePro
software and reopen or select the Restart button if the software was left open. If this problem continues, please consult your

nearest distributor or contact Data Logging Systems.

Once your software has located a logger the window will display the loggers’ description, serial number, product code and

communications Port. To proceed select the Next button.
MP D range

MP Dry Ice

The communication ports are now being checked for ESCORT products.
‘You can select the ESCORT products that you want to program and
configure by putting & check, in the box next ta the entry. Yau may click
Mext when you are ready to continue.

The communication parts are now being checked for ESCORT products.
“You can select the ESCORT products that you wart to program and
canfigure by putting a check in the bax next to the entry. You may click.
Mext when pou are ready ta continue.

Check that
the .
description _ Ready Search i Details | Sensors | Date/Time | Statup | Sur |+ _Feady Search nglalLs] Sensars | DatesTime | Startup | Gur 4| *
bOX is ticked Description I Serial Mum I Product Code ‘ Caommunications Part ‘ Diseription l Serial Mum I Product Code I Cornririi I
V1% Siress MHBI-O78-006  MPIN-D-8-L COMS v Tooe MHCE-0308-0...  MP-OE-N-B-L COm3
Search l '» ﬂgj; ” ﬂl
Cancel 1< Restart < Back ] Hext » l Help I Caricel | Is Pestart | < Back | Newt > | Help |
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MP D range

Program and Configure [

Select the
Next button

Please supply an appropnate description for the ESCORT iMiniPlus
logger(s) cunently being progiammed.

__Haad_y]_Sealch_ Details ]Sensnrs_i Data#Tima] Startup]_Sur{_‘"_ L)

or Details
tab.

Descnption:

Cancel

Shipment 1234

Change Password,
< Back. J Next > Help J

I« Restart

MP Dry Ice

=F‘rogram and Config,

Please supply an appropriate description for the ESCORT iMiniPlus
logger(s) currently being programmed. Flease supply an appropriate
description for the ESCORT iMiniFlus PDF logger(z) currently being
programmed,

Description:

Change Password |
< Back | Mext > I Help I

Cancel l< Restart

Program and

Enter a
description
of the
temperature
application

Configure Sensors).

‘Y'ou may now enable or disable the sensors that you want to the logger(s)
to record with during their next trip: If you want to change any attibute of
the sensorfs] below please click Configure. You may click Mext when you
aie finished configuing the sensors and are ready to continue.

F\sa\:lryjrsealchipelalls Sensors iDatE/Tlms] StartuDJVSur[_‘i_’_!

Group by: - i

B MName 1 Descrption I Range J Specifications I
in the 2 L‘. v & i Temp Inkernal -40 ko 70°C Oto B0 °C
’
characters
box.
Cancel ] l¢ Hestart I < Back J Next > Help J

Program and Confi

“You may how enable or disable the sensors that you want ta the logger(s]
to record with during their nest trip. If you want to change any attibute of
the sensar(s] below please click Canfigure. You may click Mext when pou
ate finished configuring the sensors and are ready to continue.

FPeady| Search | Detais Sensors | DateTime | Startup | Sunt [ 2]

Configure Senzors) Group by: ;Nnna T

Name I Description ‘ Range ‘ Specifications |
M & Air Temp Edemal 10010 40 °C 105 °C
Cancel |< Restart < Back | Ment » I Help

Select Next
button or
Date/Time
tab.

Ready | Search | Detals | Sensors Diate/Time l Startup | _Sun:_l._.l_'_j

Program and Configure

Please select the appropriate options to determine if and how the date
and time with each logger currently is being programmed should be
updated

Descrption

i Senal Num I Product Code ' Date/Time 1

E Shress

MHEI-078-006  MPIN-D-8-L 21/05/2008 50917 ...

Program and Config:

Please select the sppropriate aptions to determine if and how the date
and time with each logger currently is being programmed should be
updated

Feady| Seoich | Deteis | Sensors Date/Time | Staun | Sur 4 [+

i Date/Time |
B/16/2016 10:23:59

l Froduct Code
MP-0E-N-8-L

i Serial Num
MHCE-0308-0.

Diescription

B test

Check that © Do not make any change to the date or time of the loggerls). £ Do not make any change o the date ar time of the logger(s).
:.he d.ate and % Change to the same date and time of this computer % Change to the same date and time of this computer.
ime Is © Setta:
© Setln 21/06/2008 90310 p.m, =~ ehic: [6 /1672016 102426 8M
correct. !
Cancel ] [« Restart < Back ] Mext > Help } Cancel l 1< Restart <Back | et > l Help

Select Next button or Startup tab.
Configure the start, recording and stop conditions.
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Select Next
button or
Summary
tab.

Check that
program
settings are
what you
want.

Select
Program
button or
Program tab

Program
conditions
are being
uploaded to
iMiniPlus

Program and Configure

Duration of trip, at least:

Start new log bip;

] Bea\:lryjrsaalchipsta\lsj SsnsursJ Date/Time  Startup lSuq_‘Lj

Interval between each reading;

% Wit |00k 00m Eﬁ after a switch start

MP D range

Please select the appropriate options to determine when the loggers]
should start and finish recording their new set of readings.

User Defined Bl
|!Z ::j daps,

Finish log trip:

o After 18,045 Eﬁ 1eadings.

[0k 01m 00 =]

MP Dry Ice

=F‘ragram and Confi

Please select the appropriate options to determine when the logger(s)
should start and finish recarding their new set of readings.

Feady| Search | Detai | Sensors | Date/Time Startup | Sum 4 [ ]

Duration of trip, at least

Interval between each reading: |U

=] days. {00k 00w 05: =

Finizh log trip;

 After [BO0 3: readings

Start newy log brip:

1 Wait |00k 00m 3: after a switch start

s B —] dapsJ00R00m = ¢ ater 5 = daps [tahom LR ] daps, [00h00m O Ater [0 =] daps, J00R4Im
© g [21/05/2008 3:13pm, -] © & [z7/05/2008 1120 am rahd b [B/16/2006 10:26 M ==l T a0 [BAB/2016 11:07 AM e bl
€ Continunus logging " Cortiruous logging
T Enable the Stop buttan in the loggers] I™ Enable the Stop button in the lngger(s)
Cancel I | Restart I < Back ] Mewt > I Help } Cancel 1< Bestart ¢ Back | Mest > I Help
Program and Configure [ .Program and Confi

The follawing iz a surmary of the program options that are about to be:
uploaded to the logger(s). Please click Next when you are ready to have
the new program settings uploaded to the logger(s).

_Deta\ls]_ﬁensors] Date.v‘T\me_] Startup Summary l_Prog_laml__‘___ ’_

Diescription

J Serial Mum 1 Product Code i Batteryi Trip I

¥ Shipment 1234

MHBI-O7E-006  MPIR-D-8L ok 10

Name

Description ] Range Specifications ]

& Air Temp

Loager will start after a switch start has been detected, recording a reading every 1 Minute; and will
finizh logging when B048 readings have been taken,

Cancel ] I« Restart I

Intemal At 70°C Otob0°C

< Back. J Program > Help J

The fallowing iz a summary of the program options that are about to be
uploaded to the loggeifs]. Please click Next when you are ready o have
the new program settings uploaded to the logger(s).

Search| Detais | Sensors | Date/Time | Stamup Summary [P [ 4]

Drescription Serial Hum Product Code

| Specifications j
A00to 40 °C To9T

Name I Description ! Fange
& & Temp Extemal

Logger will start after a switch start has been detected. recording a reading every 5 Seconds, and wil
finizh lagging when 500 readings have been taken.

Cancel |< Bestart

< Back | Program > l Help

Program and Configure [

The loggers you have selected are now having their new program settings
uploaded. If you would like to program and configuie similar devices with
the same settings, you may do so now by selecting the appropriate option
and clicking Next. Othemwise, please click Restart to program and
configure another device, or Finish ta end

[escription

' Senal Mum 1 Product Code i Result 1

[¥8) S hipment 1234

MHEI-O78-006  MPN-D-E8L

Help J

=F‘rogram and Confi

The loggers you have selected are now having theil new program settings
uploaded, I you would ke to program and configure addiional lnggers
andi/ar ChatReaders, you may da so now by selecting the apprapriste
option and clicking Nest, othenmize click Finish

Details | Sensors | Date/Time | Statup | Summany Fromam | <[+

i Serial Mum l Product Code 1 Result 1

MP-OE-N-8-L

Diescription

[ test MHCE-0308-0

Canicel l ¢
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MP D range MP Dry Ice
Program and Configure Iz| Pregram and Configure @
e The loggers you have selected are now having their new program settings The loggers vou have selected are now having their new program settings
iM i n i P I us has uploaded. If you would like to pragram and configure similar devices with uploaded. If pou would like to program and configure additional loggers
the zame settings, pou may do so now by selecting the appropriate option and/or ChartReaders, you may do so now by selecting the appropriate
and clicking Mext. Otherwise, please click Restart to program and option and clicking Mest, atherwise click Finish.
been configure anather device, or Finish to end.
correctl
y Detal | Sensors | Date/Time | Statup | Summary Frogam | «[ v _ Detais | Sersors | Date/Tine| Staitup | Summary Fromam | 4 v
programmed _ . -
Description I Serial Num 1 Product Code 1 Result | Description I Serial Mum i Product Code 1 Result 1
v B8 Shipmert 1234 MHEI-078006  MPIN-D-8-L Success v [ test MHCE-0308-0...  MP-OE-N-GL Success
I~ Program and corligure additional device with the same settings ‘ I Program and configure addiional device with e same settings |
Please remember that the logger(s] require a switch start. Please remember that the loager(s] require a switch start

Select the Finish | ] - )
button Caricel ] \<F\esla|l] <Back ] Finish Help J Cancel | kRestat | <Back |[ Fnen | Hen |

Program and Configure Iz| Program and Confrgu- @

The loggers you have selected are now having their new program settings The loggers vou have selected are now having their new program settings
uploaded. If you would like to program and configure similar devices with uploaded. If you would like to program and configure additional loggers
the zame settings, pou may do so now by selecting the appropriate option and/or ChatReaders, pou may do o now by selecting the appropriate
and clicking Mext. Otherwise, please click Restart to program and option and clicking Mext. otherwise click Finish
configuie another device, or Finish to end.
' Detas | Sersors | DaterTime | Stanup | Summayy Program | ¢ | Detais | Sersors | DaterTime | Statup | Sunmary Frogram | «[ » |
Deseription | Serial Num | Produet Code | Resuit | Description | Serial Mur____ | Product Code | Resuit |
Prog ram * [ Shipment 1234 MHEI-O78006  MPIN-D-8L Failure: 2[5 test MHCE-0305-0..  MP-OE-N-BL Failuie
conditions have
not been

successfully
uploaded into

the iMiniPlus. T LPtaiam and cenfiie Addianal deise it the sAme setings [ ‘ T Pt o o addiicr ol evice b e il ‘
i
Cancel I l< Restart ] < Back J ’W] Help J Cancel | I« Bestart l < Back | ’W‘ Help |

If the upload has failed either select the Cancel button to close the software and start again or select the Restart button to
start the sequence again. If the iMiniPlus still fails to upload, contact your local distributor or Cryopak Verification
Technologies, Inc.

Starting and using the iMiniPlus

Once an iMiniPlus has been successfully programmed for use it is ready to be started. It will have the word “READY”
displayed in the top left of the screen. If it has any different information displayed, the iMiniPlus cannot be started.

To activate the iMiniPlus press and hold the START button until the display changes to a series if dashed lines and then the
temperature reading.

If a delayed start has been programmed, the word “IN DELAY” will be displayed in the top middle of the screen, until such
time as the iMiniPlus starts logging. At that time the temperature will be displayed.

During operation the last logged temperature will be displayed on the screen with the word “LATEST” flashing in the bottom
left of the screen.

By pressing the Start button during logging, the “HIGHEST”, “LOWEST” and “AVERAGE” temperature to date will be
displayed in succession and the bottom of the screen.

By pressing the Start button again, the words “HIGH ALARM” and LOW ALARM?” will flash in succession and the time
outside the alarm threshold will also be display.
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By pressing the Start button a third time, the display will return to the Latest reading.

The display will always return to the Latest reading after a 1 minute if the Start button is not pressed.

You can also have the iMiniPlus record a “bookmark” at any time while it is recording, simply by pressing and holding the
Start button for 2 seconds. The word “MARKED” will be displayed at the bottom of the screen.

If the iMiniPlus has stopped recording then the bookmark feature cannot be used.

See the section iMiniPlus Profile at the beginning of this guide for a full description of the display and button functions.

Stopping the iMiniPlus

The iMiniPlus can be stopped only if this has been enabled in the program conditions. (See Opening the Software section).
To stop the iMiniPlus press the Stop button and hold for 2 seconds, the word “STOPPED” will be displayed in the top right
corner.

If the Start button is pressed the Latest reading will be displayed and subsequent pressing of the Start button will result in the
Highest, Lowest, Average and Alarm conditions being displayed as before.

However, after 1 minute of continuous display of either feature, the display will always return to show the word “STOPPED”.

Retrieve information from the iMiniPlus

When you are ready to view the recordings that are stored in the " © ESCORT Console Pro 21207
iMiniPlus, connect it to the USB or serial cable and connect the cable to File Edit Action Help
your PC as before. If the iMiniPlus is still logging when you go to
download the readings it will continue to record without interruption so
you will be able to download again later if you choose.

Open the ConsolePro Software as previously described and click on the Download icon.

= K

In the “Download Readings” Select the Next button or Search tab.

MP D range MP Dry Ice
‘welcome to the ESCORT download readings wizard . The communication ports are how being checked for ESCORT products
This wizard will quide you through the process of downloading the *You can select the ESCORT products that you want to download by
readings from ESCORT products far viewing and analsis, Please click putting a check in the box nest to the entry, & cross in that box indicates
Mest when you are ieady to proceed. that there are currently no readings in that product to download. Yiou may
click Mest when you are ready to continue.
Ready 1SEalch i Search i
Thiz will retrieve infarmation fram loggers and/or ChartReaders thraugh the communication port(s] ta Descripti Serial N Arst Readi T
allow you to retrieve the readings that have been recorded by the loggers. s 1 enal um J ! = |ngj eva i mmy i
Please ensure all loggers are in aninterface and/or ChartReaders are also connected to the:
communication port(s) of this computer.
Press Mext when ready to proceed
I Do not remind me of this again | 5% Search l
i EG o |[[Reo ]| e | Concel | [ KRestat | cfot | Downloads [ Hep |

Select the Download button or tab.
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Select the
Next
button or
Finish tab.

Select
the

Finish
button.

MP D range

Download Readings

The communication parts are now being checked for ESCORT products.
‘You can select the ESCORT products that you want to download by
putting a check in the box next to the entry. & cross in that box indicates
that there are curently no readings in that product to download. You may
click Mest when pou are ready to continue.

‘Ready Search ]_Duwnluadj_

Description

Serial Num

First Reading

Search
< Back ] Download > Help }

Cancel I I Restart |

MP Dry Ice

The communication parts are now being checked far ESCORT products,
You can select the ESCORT products that youw want to download by
putting a check in the box next ta the entiy. A cross in that box indicates
that there are currently no readings in that product to download. You may
click. Mext when pou are ready to continue.

Search I Download |

Description First Reading

Search

Cancel | |« Hestart

I Download > l Help |

Download Readings [

The ESCORT products you have selected are now having their readings
downloaded. When all the readings have finished downloading fram the
ESCORT products that you want to wiew, you may click Next when you
are ready to continue.

__Beady_J_Sealch_ Download 1F\msh_l

The ESCORT products pou have selected are now having their readings
downloaded. when all the readings have finished downloading from the

ESCORT products that you want to view, you may click Nest when vou
are ready to continue,

Search Download | Finish |

Drescription

Restart
< Back ] Next > Help }

Cancel I [ Restart |

Description First Reading

Restart |
< Back | Meut > l Help I

Cancel |« Restart

Download Readings

The readings have now been successfully downloaded. If pou would lke
to select new start conditions for the ESCORT products that have just
had their ieadings downloaded, select the appropriate option and click
Mext when you are ready ta continue. Othemwise, you may click Finish to
wiew the downloaded readings or click Restart to download readings from
another device.

Ready J_S sarch_i Download  Finish

Loager options

' Donotupload any nevs start conditions to the logger(s]

17 Wit 00:00 2 after a switch start
 Sin [0070 =
 Sedat [21/05/2008 11:0%21 pon, =~

¥ Setlogger clock to the same date and time of this computer.  |21,/05/2008 10:53:31 p.m

ChartReader options
I~ bel

Canheel I« Restart

<Back | [ Finih Heb |

“Download Readin:

The readings have now been successfully downloaded. I you would like
tao select new start conditions for the ESCORT products that have just
had their readings downloaded, select the appropriate option and click
Mext when you are ready ta continue. Otherwize, you map click Finish ta
wigw the downloaded readings or click Restart to download readings from
another device.

Searchl Download  Finish |

Logger ophions

1+ D not upload any new start conditions ta the loggeris}
T atait IDD'DD E after a switch start
£ Startin IDD'D2 Eﬁ

" Siar [B716/2006 1042220
55

Cancel I« Bestart

< Back | Einish I Help
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MP D range MP Dry Ice

Readings and Summary is displayed.
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4 | [t 1w versien Fx]
Shipment 1234 | Trip No. 71
L | TrEwe Duscription
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Following information of a logger is displayed

Serial Number

Hjw version
Trip No.
Description

Battery

Save the data file for a permanent record. The data is saved by default to a folder called
Current fime zone “My Logger Data” in the “My Documents” folder on your computer. You can change this
Start destination if you prefer it to be saved for instance to a shared network drive. See
Finish Chapter Data from iMiniPlus that explains in more detail the information that is displayed
Sampling as a result of downloading the iMiniPlus.

Original time zone

Readings
Active

Specification

Average
Highest
Lowest

Out Of Specification
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5. Preparing iMiniPlus for use

Before you can start using an iMiniPlus to log the environment you must first prepare it for use. The

process of preparing an iMiniPlus for use allows you to define a number of parameters, including:

e How long it should log the environmental condition for, so that you can be assured that it will record for
the duration of time required? For example, if you want it to record the temperatures of a shipment that
will take 25 days to deliver, you will be able to make sure it will record the temperatures throughout
the entire 25-day period.

e How often it should log the environmental conditions?

e Under what conditions it should display an alarm? An alarm indicates when the environment being
logged is not within programmed limits.

e  This section explains how to prepare an iMiniPlus for use and what the options mean.

Getting an iMiniPlus ready for logging

Make sure the USB or serial cable is connected to your PC and to the iMiniPlus.

Parts and Products &3]

After you have opened the ConsolePro Software (see section Opening
Software) it is necessary to select the correct COM port and the
iMiniPlus from the list of products. If these are not selected the iMiniPlus
will fail to communicate with the software.

1,5 Communications Part (CM1)
W ¥ Communications Part [COMS)

You can only select one COM port at a time and if the iMiniPlus fails to
communicate with the software, select another.

Please note that you must connect the USB cable before you open
ConsolePro software. If you open the software first, then connect the
cable, the software will fail to recognize it and the COM port will be

@& ESCORT iLog

1€ ESCORT Precision

[l ESCORT ChatReader - JunioriLog

1€ ESCORT Junior

[1¢# ESCORT ChartReader - Min 2000/Inteligent
I ESCORT Mini 2000

CIMMESCORT Inteligent/wireless Mini

[ 1®s ESCORT REDI

MR ESCORT iMiniFlus

omitted from the list.
There are two ways to prepare an iMiniPlus for use, both of which will
achieve the same result.

!ngram and Configurel
& pe a@lell aewW

) ESCORT Console Pro 2.12.07 - MHCE-0308-0079-0C

Click the "Program and Configure..." item located under

the Action menu.

[JFile Edit | actionl Window Help

= E é zé Rearm... F12

Eé Program and Configure... F6
&% Download Information... F7

L8 Show Current Readings... F8

Once an iMiniPlus has been through the Program and
Configuration process to get it ready for next use, any
readings previously recorded will no longer be available
for retrieval
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Password Requirements

Password Required [F)?|
The iMiniPlus supports password option that, when enabled,
results in users being required to provide the correct password
to gain further access to the iMiniPlus. When the password
option is enabled, a window similar to the following picture will
be displayed allowing the user to enter the correct password. Product Code: — MPAN-D-8L

Descriptior: Shipment 1234

Serial Humber: ]ﬁHBl-D?S-DDB

The Program and Configure process will only continue
successfully if the correct password is supplied by the user.
Passwords are digits only, up to L4 characters.

You can enter a password to safeguard your logger from kit 1
unauthorized tampering. Make sure that you keep a note of your
password and logger serial number in a safe place. If you lose or forget the security code, the logger will
have to be returned to your nearest distributor or Data Logging Systems to restore default password.

Pagsword: |

Cancel ] Help

Program and Configuration Wizard

During the progress of the Program and Configuration Wizard, you will see a series of 5 buttons at the
bottom of the wizard box.

Cancel [« Restart < Back Next > I Help [|

The “Cancel” button immediately stops and closes the wizard. To start again you will have to select the
Program icon. The “Restart” button enables you to start the Wizard progress from the beginning without
closing the feature. “Back” enables you to go back one step in the step-by- step progress and Next takes
you to the next step. The Help button will provide description and instruction about the step you are in.
Please note that this feature may make reference to other products from time to time. Additionally some
Help documentation may not be present due to the software version you are currently using. Consult this
iMiniPlus manual if you are not sure about any description.

Search Tab - displays the description of the recorded

environment, iMiniPlus serial number, the iMiniPlus product code Seial Number,  MHEI078-005

and the communication port the iMiniPlus is connected to. Lo
Product Code: MPIN-D-8L

Battery Status: aK
If a small green arrow is present, this signifies that the iMiniPlus is | Huberof eadngsaken 28
still logging Number of sersors active: 1

Logger was started 22/05/2008 3:17:25 p.m., is recording readings evern &
Seconds, and wil finish logging 22/05/2008 3:25:40 p.m. when 100 readings
have been taken

By double clicking on this description line, the iMiniPlus Properties
box can be displayed.

The properties box displays, serial number, description, product
code, battery status, no. of readings taken, active sensors and a
summary of the logging parameters.

If the description box is unticked, it means the password to protect program settings in the logger has been
set. You will have to click on the box and enter the password.

If there is a X in the description box, only the Search tab will be displayed and the Program and Configure
Wizard cannot proceed any further.

This may indicate a fault with either the software or iMiniPlus itself (for example, low battery or lease of the
current logger has expired). Consult your nearest distributor or Cryopak technical support team
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Details and Changing Password

Program and Configure E

Please supply an appropriate description far the ESCORT iMiniPlus
lagger(z) currently being programmed

Ready | Seaich Details | Sensors | Diate/Time | Starup | Surt | ¥ ]

Description: Shipment 1234

Paszward Settings ==

Facanoid =
Confmation  [=

= | 2 | g | b )

Change Passward. I

Cancel I le Heslalll < Back ] Mest > Help I

Details Tab - Enter a description of the
temperature application in the 24 characters’
box. This can be a location, product etc.

Change Password — if you have password
protected the iMiniPlus or are wanting to
add a password for the first time you can do
this here.

Protect program settings - Tick this option
if you want to protect your programming
settings for the current logger.

Protect retrieval of readings- Tick this
option to disallow viewing of data from the
current logger without a password.

Password are digits only, up to 4 characters.

Please keep your password safe and make sure no unauthorized person has access to it. If you forget your
password, the protection cannot be disabled and you will have to return the iMiniPlus to your nearest

distributor.

If you leave the password blank but enable the protection, to access the iMiniPlus just click OK in the

Password Required dialog.

Configure Sensors and Alarm Settings

Sensors Tab - this displays the sensor information some of which can be changed by using Configure
Sensor(s) and others that remain fixed i.e. range -40O°C to 70°C. The description “Internal” refers to the
type of sensor as opposed to “External” which will display on the external sensor model.

Configure Sensor(s).. - click on this button to set up the alarm and LCD display parameters.

MP D range MP Dry Ice
Program and Configure @ Program and Configure - e M
*ou may now enable of disable the sensors that you want to the loggerls) *fou may now enable or disable the sensars that you want to the logger(s)
to record with during their nest trip. If you want to change any attribute of 1o record with during their next ip. If pou want to change any attribute of
the sensor(s] below please click Configure. You may click Next when you the sensorfs) below please click Configure. You may click Next when pou
are finished canfiguring the sensors and are ready ta continue. are finished configuiing the sensors and are ready to continue.
Rieady | Seaich | Detals Sensors | Date/Time | Startup | Sur 4| | Fieady | Search | Detals  Sensars | DateTime | Startup | Sur 4| »
Cornfigure Sensor(s) Group by Carfigure Serisor(s) Group by, [More Z
Narne ] Diescription ‘ Fange J Specifications | ‘ Description ‘ Range ‘ Specifications |
W B Air Temp Internal A0ta 70°C OtoB0°C ¥l & Air Temp Edemal -100t0 40 C 1t0§°C
Concel | | KRestat | <Back | [ Med> Heip Congll | _fcRestart fBak Rkt Bl

—— — =

v
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= —
Configure Sensors i Configure Sensors u
3 ) — — -
Specification and Alam |D|splayl Specification and Alarm l Displaw | .
v Raize alarm on below lower spec readings ID Eﬁ ¥ Raise alam on below lower spec readings 11 5:
¥ Raise alarm on above upper spec readings !50 3: | ¥ Raise alam on above upper zpec readings !9 a:
Alarm Type: 1Standard vi Ihcrement: |U_1 E: (| dlam Type: |Standard -] Ihcrement: ;0_1 E: N
Standard Alarm - B || Standard Alam
™ Mumber of conzecutive out of specification readings i'. E I™ Number of consecutive out of specification readings l'l E
W Total number of out of specification isadings i1 E: Iv Total number of out of specification readings 1 Eﬁ
Catastiophe Alam - ¥ Catastrophe Slarm
¥ Instantly raise alam on reading below: 1-40 Eﬁ Instanty raise alam on reading below: {100 -
¥ Instantly raise alam on reading above: I?U Eﬁ Instanty 1aise alam on reading above ]40 ]
Cancel ] Help ] Cancel < Back I et » I Help I
fl
'S - .

Specification and Alarm

Raise alarm on below lower spec readings — tick this box if you want to activate the low alarm and select
the value in the box immediately to the right. Note if the lower spec value is O°C, then the alarm can be
triggered at -0.1°C, not 0.0°C as this value is considered within specification.

Raise alarm on above upper spec readings — tick this box if you want to activate the high alarm and
select the value in the box immediately to the right. Note if the upper spec value is 50°C, then the alarm
can be triggered at 50.1°C, not 50.0°C as this value is considered within specification.

Increment - the grouping size used for listing out-of-specification readings.

Alarm Type

This feature allows the user to specify the condition that will trigger an alarm.
Standard Alarm

Number of consecutive out of specification readings — the alarm is triggered if the readings are
consecutively over or under the specified threshold. For instance, if the upper spec is 50°C and the value
for the number of consecutive out-of-spec readings is 3 and the logging interval is 10minutes, the readings
will need to be in excess of 50C for 30 minutes before the alarm is triggered. If the readings fluctuate
outside upper and lower threshold temperatures, the same rule applies (providing the appropriate “raise
alarm” box is ticked). Once reading(s) return inside alarm limits, the consecutive alarm is reset.

Total number of out of specification readings (cumulative) - the alarm is triggered if the total number of
out of spec readings equals the entered value. In this case the alarm is NOT reset if readings return to
within the specified parameters, and each out-of-spec reading is added to the previous one until the
number equals the entered value.

Do not set the Total number of out-of-spec readings value to be less than the Consecutive out-of-spec
readings as this will mean that the Consecutive out-of-spec readings alarm will never be triggered.

Degree-Minutes Alarm (Integrator Alarm)
The Degree-Minutes Alarm is a special feature that “integrates” temperature and time parameters into one
value.

MP D range MP Dry Ice
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Configure Sensors x| Configure Sensors m

Specification and Alarm ]_Di_s_pb__.r. i B Specification and Alarm !__[_)_@_p_lf_a_gj =
¥ Raise alarm on below lower spec readings rﬂ‘—‘g ¥ Raise alam o below Jower spec readings [1—_3
W Raize alarm on above upper spec readings m | ¥ Raise alarm on above upper spec readings m

Alarm Type: |([EEREEAR T Increment: m || Alam Type: W Increment: ’ET—-E Il

Integrator Alarm |
I~ Total number of degree-minutes below specs exceeds rﬂ Tatal number of degres-minutes below specs ]D.1 E
v Total number of degres-minutes above specs excesds ]D‘I—E Total n_umber of degree-minutes above specs 01 Eﬁ
Catastrophe Alarm = ¥ Catastrophe Alarm -
¥ ns raiee 2 -0 B Instantly raise alamn on reading below: {100 B
¥ Instantly raise alarm on reading sbove: 70 Eﬁ Instantly raisc: alarm on reading above: |40 3:

Carcal ] S Batk "W] Help ‘ Cancel l < Back i Hext > l Help i

Total number of degree-minutes below specs exceeds - the alarm is triggered when the total number of
temperature degrees below the low alarm spec is greater than the value entered.

Total number of degree-minutes above specs exceeds - the alarm is triggered when the total number of
temperature degrees above the upper alarm spec is greater than the value entered.

Catastrophe Alarm

This alarm is always secondary to the Standard and Degree-Minute alarms and there is no delay. Do not
set Catastrophe Alarm inside normal alarm limits because other alarms will never be triggered.

Instantly raise alarm on readings below - tick this box if you want to immediately trigger the low alarm
and select the value in the box immediately to the right. Note if the lower spec value is O°C, then the alarm
can be triggered at -0.1°C, not 0.0°C as this value is considered within specification.

Instantly raise alarm on readings above - tick this box if you want to immediately trigger the high alarm
and select the value in the box immediately to the right. Note if the upper spec value is 50°C, then the
alarm can be triggered at 50.1°C, not 50.0°C as this value is considered within specification.

The table below demonstrates arbitrary data from an iMiniPlus and how different alarm sources will be
triggered. This is complicated scenario for alarm settings based on:

» Upper spec alarm: +20°C

» Number of Consecutive out of spec readings: L
» Total number of out of spec readings: 5
» Total number of degree-minutes above specs exceeds: 8
» Instantly raise alarm on readings above: +23°C
Time [min] T[oC] Consecutive Total Integrator Catastrophe
0 19 OFF /o OFF /o OFF/o OFF
1 20 OFF /o OFF /o OFF/o OFF
2 23 OFF /1 OFF /1 OFF/3 ALARM ON

3 21 OFF /2 OFF /2 OFF/4 ALARM ON
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4 19 OFF /o OFF /2 OFF/4 ALARM ON
5 21 OFF /2 OFF /3 OFF/5 ALARM ON
6 22 OFF /2 OFF / 4 OFF/7 ALARM ON
7 24 OFF /3 OFF /5 ALARM ON /11 ALARM ON
8 22 OFF / 4 ALARM ON /6 ALARM ON /13 ALARM ON
9 21 ALARM ON /5 ALARM ON /7 ALARM ON /14 ALARM ON
10 19 ALARM ON/o ALARM ON /7 ALARM ON /14 ALARM ON
iMiniPlus Display
The iMiniPlus LCD can be configured to display or not display the temperature information.
MP D range MP Dry Ice
Configure Sensors Confidire Sensor i
Specification and Alam  Display |  Specificaiion and slam  Display |
¥ Enable Display ¥ Enable Display
Urits of measurement of the readings on the display: Calsils [T) Units of measurement of the readings on the display: Fahrenheit [F]
Dizplay change rate [seconds]: 11 - : Display change rate [seconds): 1 v; |
Cancel I < Back J ,Wl Help Cancel < Back i Finish I Help

Enable Display

Tick this box if you want to enable the display to show the temperature readings and statistics.

If the box is un-ticked, all other features will be greyed out. The iMiniPlus LCD will show “d-off” instead of
a temperature value. Additionally you will not be able to scroll through the highest lowest, average and out
of spec readings. The word “LATEST” will flash and if any alarm had been triggered, “HIGH ALARM” or
“LOW ALARM?” will be displayed.

The bookmarking function can still be used when the display is disabled.

When the iMiniPlus is stopped using the Stop button or it stops because it has reached the end of a
logging trip, the words “d-off” will disappear and the word “STOPPED” will appear.

Display Units of measurement

You can select the LCD to display the temperature in Celsius or Fahrenheit.

Display change rate

You can select a frequency or 1, 2, 3 or L4 seconds that the LCD scrolls between the Highest, Lowest,
Average and out-of-spec information. Note that the “LATEST” reading will only change at a frequency
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equal to the logging interval. So if the iMiniPlus is programmed to log every 1 minute, that will be the rate
at which the “LATEST” reading changes.

Checking the time clock
There may be times when the time clock on the

iMiniPlus may alter. This is the case when the battel’y Please select the appropriate options to determing if and haw te date
. SR e e
is removed and not replaced for more than 30seconds. updated

Date/Time Tab - Check that the date and time is correct.

. o Fieady | Seach | Details| Sensors Date/Time | Starup | Sur 4| |
If you have removed batteries from the iMiniPlus for

. ) Diescription I Serial Num I Product Code ' Date/Time

any length of time, make sure you either select: 9 Stress MHBLO78005  MPAN-DGL  21/05/2008 30917

» Change to the date and time on this

computer (default)
> Set to " Do not make any change to the date or time of the logger(s).
% Change to the same date and time of this computer.
.  Setto [21/05/2008 3:03:10 p.m =~

The software will always default to the “Change to the i
date and time on this computer.” option. Concel | kRestan |  <Back [ [ Wew> Hep |

Setting the Start, Stop and logging duration

Startup Tab - Configure the start, recording and stop conditions.
The left-hand side of this tab displays the start conditions and the right-hand side the logging and stop
conditions

Program and Configure &|

Duration of tri P, at least Please select the appropriate apiions to dstermine when th laggerfs) ._

hould start 2nd finish recording their new zet of readings.
If you are using the iMiniPlus to record the temperature
of a trip (shipment) for instance, you have the option

of setting up the parameters yourself or let the I e | o (R T A

ConsolePro software calculate these automatically for pusien vl ke UserDefined <]
you Interval between each ieadng. | —| degs.  [00h 01w 00: =]
: Shart new og tip: Finizh log hip:
. & Wt |00k 00m = & witch start + Afer [2049 2 readings.
The software takes the total memory available (8048 o2 euteh e H oty
c | —] daps00h 00 =] C A [5 = dews [14h0Tm =

readings) and calculates the maximum interval

c [21/0872008 913 pm. =~ ¢ 2770572008 1120 am. ={~]

between each reading and the finish log trip time and  Cortinuoss bogging

date based on the trip duration you select. You can I Enabls the Stop bulton in the loggels].
select 1day to 60day trip duration this way.

You will notice that each time you select a trip Concel | KResat | <Back | [ News | Heb

duration, the logging interval will change.

Interval between each reading

This is sometimes called the logging interval or logging rate and is described as the period of time between
each logged reading. If the interval is a low number, then the iMiniPlus memory will be filled quickly
compared to a high number. If you want to record acute changes in temperature over short periods of time,
it is best to select a low number or faster logging interval. If you want a logger to record readings over a
long period of time, then you will be best advised to use a lower logging interval or high number.

The fastest logging interval the iMiniPlus can log at is every 5 seconds.
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The slowest logging interval the iMiniPlus can log is every 18 hours.
Start new log trip

The only way to start an iMiniPlus is by using the START button. With other products it is possible to have
a timed or date start as well as a switch start.

You can also program a delay into the starting process of up to 4 hours 15 minutes. This will show
immediately after the Start button is pressed within the iMiniPlus LCD with the words “IN DELAY”. See
section Starting and using the iMiniPlus.

Finish log trip

There are several ways to cease a logging trip or period.
You can program the iMiniPlus to log until all the memory is used up (8048 readings) or you may wish to
log only 100 readings for instance.

Alternatively, you can select a certain number of days at which the iMiniPlus will stop logging. For instance
you may only want to record the temperature for a discrete period like a few days, after which you are not
interested in any further data recording.

At each time the iMiniPlus will stop logging and “STOPPED” will be displayed on the LCD

Continuous logging

If you are intending to place the iMiniPlus in an environment that you want to record temperatures 24 /7
(for example, laboratory refrigerator), you can select the iMiniPlus to log continuously. This means that the
iMiniPlus will log until the memory it filled up at which time it will start overwriting the first logged data with
the latest.

Users must be careful to routinely download data from the iMiniPlus otherwise data may be lost. Careful
selection of the logging interval is required in this case.

It is possible to download at any time while the iMiniPlus is logging, without changing the program settings.

Enable stop button in this logger(s)

The iMiniPlus Stop button can be activated through programming by simply ticking the appropriate box. See
section Stopping the iMiniPlus.

Summary and Upload Program into iMiniPlus

Once you have completed the programming, you will be given an opportunity to review all the conditions in
the Summary tab before you upload into the iMiniPlus. If you are not happy with them select the <BACK
button to return to the appropriate sections and amend.

Check that program settings are what you want.

MP D range MP Dry Ice
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The following is a summary of the program options that are about to be
uploaded to the logger(s). Please click Next when you are ready to have
the new program settings uploaded to the lngger(s)

X Program and Configure

The following is & summary of the program options that sre shout to be
uploaded to the loggerfs). Please click Next when pou are ready to have
tie: new program settings uploadad ta the Ingaer(s)

Details | Sensors | Date/Time | Statup  Summary l_F‘rogr_amJ __1_’_' Search | Detals | Sensors | Date/Time | Statup Summany |_E'_‘__:,

P}sunphnn | Serial Hum | Product Code | Balteny | Trp . | Descriplion Serial Hum Fioduct Code | Battewy | Tii
Shipment 1234 MHBIOPR-O0E  MPAN-D-84 ok

Hame: Description Fiangs: | Specifications Name | Description | Rangs | Speciications
) 8 Air Temp Inkemal A0t 70°C Oto50°C o & & Temp Extemnal -100ta 40°C Tte3°C
g el ST a1 o A Al s e it el (8 eieie acity moy Al 1 Mt e il Logger will start aflet a swilch starl has been delected. recording a reading every 5 Secands, and wil
finish logging when B048 readings have been taken finish logging when 500 readings have been taken,
Coel | icmesta | cgeek | [Fogens | Hep | Cancel < Restatt <Back | [ Pogams | Hep

Program conditions are being uploaded to iMiniPlus

Program aj nfigure Program and Configure . e 4 ﬂ

The loggers you have selected are naw having their new program settings The loggers pou have selected are now having their new program settings
uploaded. If you would like to program and configure similar devices with uploaded. If you would like to program and configure addiional loggers
the same settings. you may do so now by selecting the appropriate aption andror ChartReaders, you may do so now by selecting the appropriate
and clicking Mext. Otherwise, please click Restart to program and option and clicking Next. othenwize click Finish.

configure anather device, or Finish to end.

Detais | Sensors | DatedTime | Startup | Summary Program | 4| | Details| Sensors | Date/Time | Statup | Summary Program | <[ ]
Description | Seial Num | Product Code | Fesut | Dssoription | Serisl Hum | Product Code | Rresult |
B¥chipmert 1234 MHBIO7B006  MPAND-BL = roves MHCE-03080..  MP-OE-R-EL

Tahea I YH I Help J Cancel | b < Back Help |
il
The iMiniPlus has been correctly programmed
MP D range MP Dry Ice
The loggers you have selscted are now having their new progiam sstings The Inggeis you have selected 2re now having theil new program settings
uploaded. If you would like to program and configure similar devices with uploaded. If you would like to program and configure additional loggers
the same settings. you may do so now by selecting the appropriate aption and/or ChartReaders, you may do so now by selecting the appropriate

and clicking Next. Othenwise, please click Restart to program and option and clicking Mest, othenwise click Finish
configure anather device, or Finish to end.

Delalls]VSensors] Date#T\me] Slalluﬂ Summary  Pragram ] _‘_1_’_'

Dessiiplion [ SerialNum | Product Code: [ Resut | Dascription [ Serialtum [ Product Code | Resul [

w (28] S hiprent 1234 MHELDTB-006  MPAM-D-6L Suncess st MHCE-03080..  MP-DE-N-8L Sucness

I~ Pragrsm snd confiaure additional devise with the same seifings | I Program and configure sddiional device with the same seftings |
Pl se remerber that Ine ggerelsenute o stehisioi Pl remermbier that e Ingger|s) rsquie s switch start

Carcel ] [ Haslan| <Back J Finish Help J Concel | KRestat | <Back | [ Ensh | Hep |

If the program settings have been uploaded correctly the blue progress bar will show 100% and the word
“Success” display in the Result field. There will also be a tick next to icon in the Description field. Select
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the Finish button and when ready start the iMiniPlus and place in the environment to be recorded. See

section Starting and using the iMiniPlus.

Program upload Failure

If the upload has failed either select the Cancel button to close the software and start again or select the
Restart button to start the sequence again. If the iMiniPlus still fails to upload, contact your local distributor

or Cryopak Verification Technologies

Program conditions have not been successfully uploaded into the iMiniPlus.

MP D range

=

Program and Configure Ii‘
The loggers you have selected are now having their new pragram settings
uplaaded. |F you would ke ta program and configure similar devices with
the ame settings, you may do so how by selecting the appropriate option
aind clicking Next. Otherwiss, plesse click Restart to program and
configure another device, o Finish to end.

Details | Sensors | Date/Time | Startup | Summary  Program | 4| ¥ |

Drescription ' Serial Num 1 Product Code i Fiesult I
¢ 8] S hipment 1234 MHEI-076-006  MPM-D-8L Faiure

I~ Program and configure additional device with the sams ssttings

MP Dry Ice

The loggers you have selected are now having their rew program settings
uploaded. If pou would like to program and configure additional loggers
and/or ChartReaders, you may do so now by selecting the appropriate
option and clicking Mest, othenwise click Finish

_Detalls | Sensors | Date/Time | Startup | Summary Fromam | 4] »

Description i Serial Num | Product Code 1 Fesult I
*Btest MHCE-0308-0. WP-OE-N-8-L Failure

| ™ Piogram and configure additionsl device with the same settings |

Concel | iRestat | <Back | [ Finish Hep | Cancel Ik Restait

<Back | [ Emsh | Hen |

6. Results from iMiniPlus

The iMiniPlus stores the logged readings in its internal memory so you must use the ConsolePro software
to extract these readings through the USB or serial adaptor and into a format that can be displayed on the
PC screen. It is usually very important that the information retrieved from an iMiniPlus is retained. Through
the software you can save the information retrieved from an iMiniPlus to your disk drive so that you can
view the information at a later date. This chapter explains how you can retrieve the logged data stored
within an iMiniPlus and have the software display it to you on the screen in a meaningful way.

Getting results from iMiniPlus

Make sure the USB or serial cable is connected to your PC and to the iMiniPlus.
There are two ways to retrieve the data from an iMiniPlus, both of which will achieve the same result.
Click the Download Information icon on the toolbar

Click the "Download Information..." item located under the

{5 ESCORT Console Pro 212,07 - MHCE-0308-0079-0¢
Action menu.

[JFile Edit |Action| Window Help

EES '@ Rearm... F12
@ Program and Configure... F6

& Download Information... F7
L§ Show Current Readings... F8

The process of retrieving data stored within an iMiniPlus
does not erase it from the memory. If the iMiniPlus is
currently recording while you retrieve the information, it will
continue to record without interruption.

The Download Information feature initiates the Download
Wizard.
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Download Wizard

During the progress of the Download Wizard, you will see a series of 5 buttons at the bottom of the wizard

box.
L Cancel l< Restart

< Back

MNext > Help
Ltet> ]

The “Cancel” button immediately stops and closes the wizard. To start again you will have to select the
Download icon. The “Restart” button enables you to start the Wizard progress from the beginning without
closing the feature. “Back” enables you to go back one step in the step-by- step progress and “Next” takes
you to the next step. The Next button is preceded by the “Download” button. The Help button will provide
description and instruction about the step you are in. Please note that this feature may make reference to
other products from time to time. Additionally some
Help documentation may not be present due to the
software version you are currently using. Consult this
iMiniPlus manual if you are not sure about any

description.

Download Wizard Stari page

>

Displays information about the iMiniPlus along
with the date and time of the first reading.

Download Readings

Ready Seatch | Dowriad |

]

The communication poits are now being checked for ESCORT products.
“fou can select the ESCORT products that pou want to dovendoad by

pulting a check in the box nest bo the entty, & cross i that box indicales
tht thete are cunrently no readings in that product to download 'You may
clhick Mext when pou are teady to carkrue.

¥ | Shipmerit 1234 MHEI-075-006

Fist Reading |  Inteeval | Comme..

1 Minuie

COMS

T - |

Cancel | KResn | <Bock | [Downoads |  Hep |
Indicates that the Download was successful.
ﬁ

Download Readings rz
‘Whalcome to te ESCORT download readings wizard.
Thiz wizard wil guide you through the process of dowrdoading the
teadings from ESCORT products for siewing and analysis, Flease click
et wihen vou are ready bo proceed.

Ready | Search |

This will ieliieve information fiom longers and/'or ChartReaders through the communication port(s] 1o
alow you ko refrieve the readngs that have been recorded by the loggess.

Fleass ensure all lnggers ae in 2 i andyor Ch e alo d by the
coemmuracation poits) of this computes,

Fress Next when ieady to procesd

™ Do mot remind me of this again

Cancel | et | | [ Het> Heb |

Displays information about the iMiniPlus along
with the date and time of the first reading. Click
‘Download’

Download Readings |Iz|
The ESCORT products pou have selected aie now having ther readings
downloaded ‘When all the ieadings have finished downloading from the
ESCORT products that you vari bo viev, wou may chck Nest when pou
are ieady to continue.

 Ready| Search Dowrioad | Fiish |

e
Concel | KRestat |  <Back | [ New» | Hep |




If FAILURE appears in the Result and there is a RED X next to in the Description this may indicate the
iMiniPlus has already been programmed. If this is not the case, there is a fault with the iMiniPlus and it will

Download Readings |£

The readings have now been by dovnloaded. I pou would like
to select new start condibons for the ESCORT products that have just
had ther readings zslect the i tion and chck.
Mext when pou ane ready to continue. Otherwizsa, pou may click Finish to
wiew the dirgs of click Restart bo download readings |

ancther device,
Ready | Search | Dowrload Finish |

Logger cptians

% Do ot upload any new stat condiions to the loggei(s)

Cowiat (0000 =] sfter s switch st

© e [oe0 =

© ciecar [05/2008 M08 Z1pm =1v]

¥ Setlaggar clock to the same date and time of this computer. [21/06/2008 10593 pm.

ChaslFeader ophions

I" D:

Cancel [ Rrestart <Back | Finish Help

need to be returned to your distributor.

You have the option of programming the new start
conditions. This may be help for instance when you
are having to reset a large number of iMiniPlus
loggers for a new application. Otherwise leave
Logger option at default setting “Do not upload any
new start conditions to the logger(s)”
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Inspecting the information at close range

When a file is displayed either from downloading or from calling up a stored data file, the file first appears
as a list of readings. It might look something like this:

@ ESCORT Console Pro 2.12.07 - MHCE-0308-0079-0073 - [MHCE-0308-0079-0073:2] l = ‘ =R x
Dfile Edit Action Window Help _ = x
HEa 860 BB  &F38U AFW
(e My == Index Elapsed Date Time External Z]
&l views ]@ ks | Analysic 1 Time (] —
=-[&= Readings erial Number - -
EN =] a Serial Numb: MHCE-0308-0079
- [ Ustof readings Hhw version 2.0i
-[&& Readings and summary 5
2.1y 2D Graph Trip No. 73
: 5= Line escription -
: D p TO08-6
b= Step Batt oK
5B Summary — = -ery - -
-EE Overview Original time zone [UTC-5:00) Daylight time
EE Statistics Current time zone [UTC-5:00) Standard time
§ Analysis PR
- g Start 692016 1:00:42 PM
E Cut OF Specification
EE Marked Readings Finish 692016 9:04:42 PM
Sampling 10 Seconds
Reading 2905 [484 Minutes)]
[Rats pod Procts =20 Active -100.0 to 40.0 °C
|_—.|n_;5_y1 Communications Port [COM1] Specificaliun 1.0t0 9.0 °C
E#Commumcations Port [COM 3] Average 241
Highest 24.5
T = 2 Lowest -80.3
l =) Out Of Specification 22115 Seconds
v & ESCORT iLog/Qualaire l
D@ ESCORT Frecision 90 Seconds from -80.3 to -80.3
[ ESCORT ChartReader 10 Seconds from -80.2 to -80.2
DgESCDHT Junicr 560 Seconds from -80.1 to -B0.1
Igs# ESCORT Mini 2000/ nteligent ChartR eader z
3 Minutes from -80.0 to -60.0
CIFSESCORT Mini 2000
C1RESCORT Inteligent/wirsless Miri 1250 Seconds from -79.9 to -79.9
[1®s ESCORT RED 3 Minutes from -79.8 to -79.8
o] -
PABRESCORT MiiPlis 21 Minutes from -79.7 to -79.7
v 14N Sercnnds fram -79.6 tn -79.R ﬂ
‘ m il F _]_\'—1 _’J
For Help, press F1 | [num 4
—_———

View Manager

The View Manager is a useful data viewing tool and by default, occupies the left side of the ConsolePro
window. The View Manager will only be functional when a set of data has been opened or been
downloaded from an iMiniPlus.

i Wiew Manager ax View Manager - View Manager . X

Views I@ Unks | B8 Anaysis I Viswis @ Links Analysis l Views | £ lnks (B Analysis
= [&= Readings Description | Details | @l Calculated Values

[ Lt of redings T008-6 (MHCE-.. 6/3/2016 2.00... £ Mean Average

[E= Readings and summary Extemal 10010 40°C £, Highest reading
=l 2D Graph @7, Lowest reading

[B= Line & Dewpoint information

_ [t Step CIPH Process Hygiene Index (PHI}

BN Sum'nary [CInkT Mean Kinetic Temperaturs (MKT)

[ Overview g Growing Degree Day

StatustlF:s I User Defined

[ Analysis g8 Custom

[F Out Of Specification

= Marked Readings

If you want to see the View Manager in any other ConsolePro window location, simply select and drag. The
View Manager has 3 tabs:

1. Views - Manages the type of reading, graph or summary you would like to display.
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2.
3.

To hide or display the View Manager,

choose Options from the Edit menu. Select

or deselect Display the View Manager

option from the Generaltab. Alternatively
you can right click on the menu or toolbar
area to select the View Manager. As shown:

Views

Links - Manages which data you would like to analyze or compare.
Analysis - Manages which type of analysis you would like to add in the displayed readings or graphs.

@ ESCORT Console Pro 2.12.07 - MHCE-0308-0079-0073 - [MHCE-0308-0079-0073:2]

|l =d&=

| View Manager

‘ [JEile Edit Action Window Help

R B

Elj views ]@’.’:‘.ks | B anzyss I

SR SEE SHES &S

View Manager
Ports and Products
File

Edit

Action

Help

The Views window has 3 top-level headings. To expand or collapse the content of any headings just left
click on it. Each heading contains a drop down list of further items. To display the item double-click on the

item you would like to see.

Readings

List of readings - displays a table
with separate line for each reading
taken. Each line shows the date and
time the reading was made and the
measurement made by each sensor.

EE Bl Edit Action Window Help

==l

Readings and summary

Displays reading summary report
followed by detailed list of actual
readings. Summary report includes
such facts as the serial number of
the iMiniPlus and a description of the
environment recorded, trip number,
start and finish dates, time zone,
number of readings, etc.

For e, press 71

=HdE= HE B A&ZSU ATN
[Wiew Manager < %] [Index Elapsed Date Time Internal j
'i"“ ];J:.:J Links | (B Analysis ] Time ra
= [&= Feadings = 1 00:00:00| 2/06{2008| 7:55:39 p.m. 20.9
i B e EEE 2 [00:00:05] 2/06/2008] 7:55:44 p.m. | 2NN
E E Readings and summary
50 20 Graph 3 |on:n0:10| 2;06/2008) 7:55:49 pm.| 212
Eoq % Lire: 4 00:00:15| 2/06{2008| 7:55:54 p.m. 21.3
i |B= step . e
S Summey 5 00:00:20( 2{06/2008| 7:55:59 p.m.| NENS
[ Overiew 6 | 00:00:25| 2/06/?008| 7:56:04 p.m.| 21.7
itatist'_cs il 7 | oo:00:30] 2706/2008) 7:56:09 p.m. | NS
= - : 8 [o00:00:35] 2/06/2008] 7:56:14pm.| 219
T = |9 |0U:00:4] 2/06/2008] 756119 pam.| 221
D#Commumcatmns Part [COMT] 10 | D0:00:45( 2/06/2008| 7:56:24 p.m. 22.3
¥ Commurications Poit (COMS] 11 | oo:00:50| 2/06;2008| 7:56:20 pm.| 22.4
< 5 12 | 00:00:55( 2/06/2008| 7:56:34 p.m. 22.7
5@ TR 13 | 00:01:00( 2/06/2008| 7:56:39 p.m. 229
LLag i e R
D@ESEDRT Frecision 14 | 00:01:05| 2/06/2008| 7:56:44 p.m. 23.1
) ESCORT ChanRieadsr - JurioriLog 15 | 00:01:10( 2{06/2008] 7:56:49 p.m.| 23.2
¢ ESCORT Junior L 16 | 00:01:15| 2/06;2008| 7:56:54 pm.| 233
E\@ ESCORT ChartReader - Mini 2000/n
IR ESCORT Mini 2000
T e e A v -
< | > 18| "
#ur Help, press FL (MU i 2
FFEe B fution Wi Hap = 7| X
BEHIa L&D B CREC T R 6
[ e Fianager =%l Index Elapscd | Date | Time | Internal =
B e |u':?u-|: | @ | Time ES i
= i Aeedrgs __ Serial Mumber MHB-070-006
[ Lstcfcadrgs 1.0c
|5 Fieedrgr end cmmary
= |4y 23 Graph 14
[3= Lre I ptinn 1234
= tep Batlery oK
= [ Suwnay — -
[ Dvewiew Driginal time zone [GMT#12:00] Standard fime
l:: St Cument time zone [GMT+12:00) Standard time|
E A 75530 g,
[EE Harbod Amadings PHGLAO08 TE654 poan,
5 Seconds
Headings 1E [£h Seconds]
 Active -A0.0 to 70.0 °C]
0.0 10 50.0°°C
Sl and B o Average vl
T Commerisetin P (G Highest 23.3
V1 A e isatioen Pt 45| Loweat 20,01
Out Of Specilication None
. " 1 ZM0G/2008. 7:55:39 p.m, 20.9
= 2 W0:00:05 #:66:44 pm. [
LTRSS T e T
i en 3 | uu:uu.w ZHOBO0A 755148 p.m, 2.2
B ESLAHT s 4 000015 7:55:54 pm, 21.3| —
3 4 U020 262008 Fhecsd pm. R
Jég:_ugla@;ﬂm-mi 200 B 2000 7:56:04 p.m, 21.7
CIEEsCoRT Wi
IMESCORT Irichqeseiekas i 7 00:00:30( 262008 7:56:00 p.m. RS
—Bs conRT REDI B OIS 2MEZI0E FEETS pom. 71.49
FPESCTRT iinPhus ] 00:00:40] 206/2000. 7:56:19 pm. 221
10 00:00:45] 2/06/2008] 7:56:24 pm. 223 -
= : =il g :
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2D Graph.

Line - displays the logger’s reading
as a line graph.

Step - displays the logger’s readings
as a step graph.

You can enlarge a section of the
graph with the mouse. Move the
mouse to one corner of the area you
want to zoom, press the left mouse
button, drag the mouse to the
opposite corner, and release the
button to enlarge a section of the
graph. Press the toolbar zoom button
or right click the mouse to restore
(un-zoom) the graph.

Summary.

Internal [*C)

L o ISR

30.0
25.0
20.0
15.0
10.0

ZJI]BJZI]IiB o 2.-'.05.-'|2[I[IIB o ZIIUWIZI][IB ’

' ZI:UBIZUI;B I IZ.-'IIJG.-'IZIIIZIIB I

8:41:01 p.m.  8:41:31 p.m.  8:42:01 p.m.  8:42:31 p.m.  8:43:01 p.m.
S Name Int I
Legend —_—
Description Shipment 1234
Serial Number | MHBI-078-006
Internal ["C)

35.0

30.0

25.0

20.0 -

15.0 ¢---

L e e L Lt SLLL LI EELLLELS:

]
21062008 2/06/2008 2{06/2008 2/06/2008 2{06/2008 2/06/2008
8:41:01 p.m.  8:41:31 p.m. 8:42:01 p.m. 8:42:31 p.m. 8:43:01 p.m. 8:43:31 p.m.

Sensor Name

Internal

Legend

Description

Shipment 1234

Serial Number

MHBI-078-006

Overview - displays overview information
of the current logger such as serial
number, trip number, battery report, time
zone, start and finish dates, number of

readings, readings interval,
range and specification.
External
ra

Serial Number | MHCE-D308-0079

Hiw version | 2.0

Trip No. 73
Description TOO8-6
Battery 0K

logger’s

Statistics - displays the serial number, the
description, the highest and the lowest value
of readings, the average value of readings,
the Process Hygiene Index (PHI), Mean
Kinetic Temperature (MKT), a Custom value

and Grower Degree Day (GDD).

Original time zone

[UTC-5:00) Daylight time

Current time zone

[UTC-5:00] Standard time

Start 6912016 1:00:42 PM
Finish 6/9/2016 9:04:42 PM
Sampling 10 Seconds
Readings 2905 (484 Minutes]
Active -100.0 to 40.0 °C

Specification

1.0t 9.0°C

External
°C)

Serial Number MHCE-0308-0079

Description TO08-6
Average -24.1
Highest 24.5
Lowest -80.3
PHI Aerobic 0.01
PHI Anaerobic 0.01
MKT 517
Growing Degree Day 0.0
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Analysis — displays a summary report

and includes previous parameters.

External
)

Serial Number

MHCE-0308-0079

Hjw wersion 2.0i
Trip No. 73

Description TO08-6
Battery 0K

Original time zone

(UTC-5:00) Daylight time

Current time zone

[UTC-5:00) Standard time

Start 6/9/2016 1:00:42 PM
Finish 6/9/2016 9:04:42 PM
Sampling 10 Seconds
Readings 2905 [484 Minutes]
Active -100.0 to 40.0 °C
Specification 1.0t0 9.0 °C
Average -24.1
Highest 24.5
Lowest -80.3
PHI Aerobic 0.01
PHI Anaerobic 0.01
MKT -b.17
Growing Degree Day 0.0

Out Of Specification

22115 Seconds

Marked Readings - displays the bookmarked

readings.

Links

The Links window provides a way to analyze and/or compare data from
multiple iMiniPlus loggers, which could have been logged over different
time periods and/or different logging intervals.

Simply download the iMiniPlus loggers you are interested in comparing.
The data may also be from previous logged period on the same iMiniPlus.
For download instructions see the section “Download Wizard”. In the Links

Out-of-Specification —

displays

a

breakdown of the out of specification

readings.
External
rc
Serial Number | MHCE-0308-0079
Description T008-6

Out Of Specification

22115 Seconds

90 Seconds from -80.3 to -60.3

10 Seconds from -80.2 to -§0.2

560 Seconds from -80.1 to -60.1

3 Minutes from -80.0 to -80.0

1250 Seconds from -79.9 to -79.9

3 Minutes from -79.8 to -79.8

21 Minutes from -79.7 to -79.7

140 Seconds from -79.6 to -79.6

340 Seconds from -79.5 to -79.5

10 Seconds from -79.4 t0 -79.4

1 Minutes from -79.3 to -79.3

40 Seconds from -79.1 to -79.1

50 Seconds from -78.9 to -7§.9

40 Seconds from -78.8 to -78.8

40 Seconds from -78.6 to -78.6

20 Seconds from -78.4t0 -78.4

40 Seconds from -78.2 to -78.2

20 Seconds from -78.1 to -78.1

20 Seconds from -78.0 to -78.0

Index Elapsed Date | Time | Internal
Time "cy
Serial Number MHBI-OT8-006
Hjw version 1.0c
 Trip No. 21
Descriwnn Shipment 1234
Battery oK
Original time zone [GMT+12:00) Standard time
Current time zone [GMT+12:00) Standard time
Start 2/06/2008 9:48:48 p.m.
Finish 2j062008 9:57:03 p.m.
Sampling 5 Seconds
Readings 100 [495 Seconds]
Active -40.0 to 70.0 °C
Specification 10.0 to 25.0 °C
1 00:00:45 | 2/06/2008] 9:49:33 p.m. | IENNNEEE
2 00:01:55|_2/06/2008]_9:50:43 p.m. EI
Vies Manager ]
i &1k |Gt |
Besenelien i Dok
= P Shipmew 123 MHE-IFO0E) 262000 24340 o
| Irtemel A0:70T
= I Shipmen sbce MHOMIPS00E MG/200 31522 0m
¥ Irtemel AT

window you can see all the iMiniPlus loggers or data that ConsolePro has currently open and displayed.
Simply select the iMiniPlus and its sensor to include it into the current display window. Note that
ConsolePro shows the “/nternal” under the description and serial number of the iMiniPlus. This is
automatically selected when the parent box is selected. It refers to the sensor description of the iMiniPlus
model MP-IN-D-8-L in which the sensor is housed internal to the iMiniPlus body. The word “External” will
be show in the model MP-OE-D-8-L and it refers to the sensor that is externally connected to the
iMiniPlus via a one meter cable.
Each time an iMiniPlus is downloaded into ConsolePro software or a series of data is opened, a separate
Readings and Summary box is opened like the picture below:
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Each iMiniPlus dataset can be maximized into
the ConsolePro window and then be selected
through the Window menu as below:

redow | Help
lew Windaw. . rEall SR
£ ¥ MHBI-078-006-0021
Clese Index Elapsed
Close A Time
Caseade Serial Number
Tile Horizortaly Hiw version
Tie Wertically Trip No.
Arrangs loars Description
B St LVHELO7B-006-0022 Battery
[ Anayei L] 2MHEL-076-005-0021 Original time zone
E Umurswm—ﬂ'w
[ Maiked Readngs Start —

Multiple Trip Synchronization Wizard

When more than one set of data appears in the Links
window and is selected with a tick, the Multiple Trip
Synchronization Wizard will start and guide you
through the process of including the data from the other
iMiniPlus into the current display.

To compare log trip data gathered from multiple
locations at similar periods of time, it is recommended
that you select the option “Compare trip data based on
actual date/time of each reading”. For example, this
will allow data recorded from one site to be compared
with data from another during the same interval of time.

To compare log trip data gathered from multiple and/or
the same location during different periods of time, it is
recommended that you select the option “Compare trip
data from different date/time period(s). This is useful
for comparing current log data with that of a previous
week.

Multiple Trip Synchronisation

The falowing options determine how different tme perods for each tip of
loaged ieadings should be syncheonised, thereby daﬂemrmgu a
compatative of conlinuous analyes it 1o be perdomed

Ready Swchiorise | Custom |
" Compare lip dala based on achusl date/ine of sach reading.
" Compare tip data from diferent date/time pesiodiz).
= Manualy define how the i data is to be compared with other bip data.
Thiz option wil sllow you bo marualy determme how the data should be compared. This oplicn is
useful e when the shove bwo oplians da nal meel pour iequirsmenls, af pou need o compensabe for
a vaniance in the date/lime of 2 logger. For example, the dateflime in lopger & was § seconds ahaad

of the: date/time in logger B, or lopger & was peogrammed with daglight in effect and logger B was
programmed with dayight saving not in effect.

Cancel | KRestat | <Back | [ News | Hee |

‘wheleame b the wizeed that wil guide you thiough the pocess of
inchuding data from muliple bips ko & single window for viewing and
analysi. Please chok Ne when you are ready o pioceed

Ready | Synchiarise | Custom |

This will guide the shep: i rip data i
wibich map have been logged over Mlm nsnods and/or difesent lagging intervalz so that the:
data can be viewed side by side or the data can be viewed overaid.

By fing dilferer time perind jsali ive of

parformed.

For exampls, with comparative analysis bou mwmhmmmwbwdumaumm
week with readings with logged duing the cument weak. With to
Wmsad’cusMMDlelngpewlhangnedmamhmuyudmmaemhw
logged i its own unigue location.

Prasz Maxt when eady to procead.

™ Dot remind me of this again

Cancel T Heb |

Multiple Trip Synchronisation

The folowing oplions determine how differant lime pericds for sadllllmf
logged mmﬁus should bes}ﬂdmed, thereby detemiring # &

Ready Synchionise |
& Compare ip data based on actual date/lime of each reading.
" Compare tiip data from diferent date/time pesiod|s)
" Marually define how the lip dat i 1o be compared wilh cther lip dat.

The soltware will display the d dative Lo the il daleti ch read recorded This
oplinnl:usah.llotmvmguendsndaaashyo:madowlmmd[ucmlr\glogupdda
gathered from mulliple locations/skes that occurmed of the similar periods of time. For example, this wil
allows for data recorded fram site & during the previous week: to be compaed with data reconded fiom
sile B that wae alzo laken during the previous waek.

Cancal K Restait <Back | [ Finish | Help

To customize how the log trip data from an iMiniPlus is included, select the option “Manually define how

the trip data is to be compared with other trip data”.
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Multiple Trip Synchronisation

This step provides you with a screen that will allow

you to manually adjust the alignment offset through &ﬂﬂ?ﬁﬁ?&”ﬁﬁﬁ:ﬁ”ﬁf?ﬂﬁ@m
the Reading Offset controls. FEERTIE
e Serial Number displays the serial number of Reay| Synchrenise. Custom
the iMiniPlus to be added to the current view. T T
e Description displays the description of the Desciption: Shipment 1234
iMiniPlus to be added to the current view. Feading Number: =] @ [z/me/2008 34853 pm =]
e Reading Number shows the reading number, [ Seiglbum | Fist Reading | Interval |
the iMiniPlus has/would have taken at the MHELOTS006  3/06/2008 51522 pm 5 Ssconds
date/time specified in @ field.
e Reading Offset allows you to adjust first
reading time of the currently displayed
iMiniPlus to synchronize it with first reading Reading Offset: o = dys [120000am Suggest
:?ti;fcgfel::hvnil:\l;{s that is going to be added e o |

You can use Reading number or @ fields to set

time and date to be used for the first reading of the iMiniPlus to be added or you can use Suggest button

to allow software set first reading date and time.

Also you can see details of the currently displayed iMiniPlus: description, serial number, date and time of

the first reading, interval between readings.

Analysis

When a file is displayed either from downloading or from calling up a

View Manager

stored data file, the software will automatically calculate and display

some statistics of the recorded data. These statistics can be displayed
in the Readings, 2D Graph and Summary features of the View tab.
When choosing a 2D Graph view, these statistics can be optionally
displayed in the graph window.

The Analysis window has 2 top-level headings. To expand or
collapse the content of any headings just click on it. Additionally if you
right click on the Values or User Defined statistics, you will be able to

& Calculated Values

Mean Average

Highest reading

Lowest reading

- B4 Dewpoirt information

-IPH Process Hygiene Index (PHI)

- CIMKT Mean Kinetic Temperaturs (MKT)
-[JEM Growing Degree Day

Pt

| User Defined

w1 Custom

edit and/or view reference material. See right image below:

Calculated Values

Mean Average

Select this option to display the average value of readings in the 2D graph
legend.

The Mean Average reading is the arithmetic mean of the sequence of
data points. It is calculated by adding all the data point values together
and then dividing the total by the number of data points. Mathematically
this formula can be expressed as illustrated in the following picture:
Where:

av the calculated arithmetic mean
n the number of data points to include in the calculation
t; a data point to include in the calculation

= File Edit Action Window Help

== = B Bac

Wiew Manager * X

Ejviews | €7 Links Eanal... I
I Calculated Yalues
[1£ MeanAverage
[ £, Highest reading
(1, Lowestreading
14 Dewpoint information
[IPHI Process Hygiene Index [PHI)
[ IMKT Mean Kinetic Temperature (MK
@ Growing Degree Day
| User Defined
= |

v Allow Docking
Hide

Edit Custom Yalue. ..

For example, if there were 5 data points to calculate the arithmetic mean of and they were, 12.3, 15.9,

16.2, 14.7, 14.9, then the arithmetic mean would be 14.8.
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Highest reading

Select this option to display the maximum value of the iMiniPlus readings in the 2D graph legend.

Lowest reading

Select this option to display the minimum value of the iMiniPlus readings in the 2D graph legend.

Dewpoint information

This statistic is not available on the iMiniPlus. (Relative Humidity loggers only)

Process Hygiene Index (PHI)

Select this option to display the aerobic and anaerobic process hygiene index of iMiniPlus readings in the

2D graph legend.

Process Hygiene Index (PHI) is:

e a unit of potential microbial growth equivalent to one generation of Escherichia coli ;

e an approximation of the amount of potential bacterial growth during the cooling process of meat

products from slaughter until the meat has cooled to 7°C (44.6°F) or less;

e a way of evaluating the overall hygiene of the meat cooling process.

Process Hygiene Index (PHI) consists of:

e Aerobic growth (growth on the outer layer of the meat carcass) of Escherichia coli during the cooling

process;

e Anaerobic growth (growth internal to the meat carcass) of Escherichia coli during the cooling process;

e the temperature of the meat during the cooling process.

The Process Hygiene Index (PHI) standard:

The MAF (New Zealand) Industry Standard
6 indicates that PHI values should not
exceed a maximum of 14, and a mean of 7.
For more detailed information on the
application and use of PHI calculations, refer
to New Zealand Ministry of Agriculture and
Forestry (MAF) Industry Standard 6,
Processing of Edible Product, which is
available through the Internet site

(http:/ /www.maf.govt.nz)

Software calculates Process Hygiene Index
(PHI) using the following formulas:

T is the temperature in °C.

Mean Kinetic Temperature (MKT)

Temperature {(°C)

Generationshour

Aerobic growth
7-30 (0.0513 % T -017F
30-40 (0.027 T + 0.55F
40-47 2.66
<Tor=47 0

Anaerobic growth

7-305 (00433% T-0.15F
305-40 (0.0163x T + 0676
40 -45 177
<] ar=47 1]
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Select this option to display the Mean Kinetic Temperature of the iMiniPlus readings in the 2D graph legend.

There are some products and materials that
exist which have accelerated rates of

AH/R

degradation at higher temperatures. For

example, perishable food items,  -in E‘AH/RTE + E‘AH/RTZ‘ + .+ E‘AH/RTﬂ

pharmaceutical products and many forms of
bacteria can grow/degrade exponentially as
the environmental temperature increases.

P

Mean kinetic temperature is a calculation that accommodates the non-linear thermal effect temperature can
have on products. Mean kinetic temperature is represented as the equivalent temperature the product was

thermally subjected to during the period of time the
various temperature readings were recorded. As an
illustration of how the MKT calculation will affect an
expressed mean for a yearly calculation (important for
the long term storage of critical drugs and chemicals),
here is an illustration:

If the temperature is constant for an entire year, but is
"off" for a single month of that year, there will be a
difference in the calculated arithmetic mean (the sum of
all of the measurements divided by the number of
measurements--a simple mean) and the kinetic mean.

The following graph and table show the differences which
are calculated by both methods:

Mean Kinetic Temperature

244 1 L
15 20 25 20

One Month Temperature

Effect on Kinetic and Arithmetic Mean Temperatures on storage for one month at other than 25° C.

Temperature (one month) Mean Temp.(Kinetic) Mean Temp.(Arithmetic)
15 24.48 24.17
16 24.51 24.25
17 24.54 24.33
18 24.58 24.42
19 24.62 24.50
20 24.67 24.58
21 24.72 24.67
22 24.78 24.75
23 24.85 24.83
24 24.92 24.92
25 25.00 25.00
26 25.09 25.08
27 25.18 25.17
28 25.29 25.25
29 25.41 25.33
30 25.53 25.42

Although the effect is not dramatic, it is clear that the MKT method weights the higher temperatures in a

series more than the lower temperatures.

GrOWIng Degree Day Growing Degree Day Calculation El
GDD are calculated by taking the average of the daily maximum Baselne [  °C
and minimum temperatures compared to a base temperature, 7., Cutoffs
(usually 10 °C). As an equation: Upper cutoff [ oC
Lower cutoff I— AE

I
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GDDs are typically measured from the winter low. Any temperature below 7, is set to 7, before
calculating the average. Likewise, the maximum temperature is usually capped at 30 °C because most
plants and insects do not grow any faster above that temperature. However, some warm temperate and

tropical plants do have significant requirements for days above 30 °C to mature fruit or seeds.

Custom Value
Select this option to display custom defined value of readings in
the graph’s Legend. Double clicking on the Custom item opens R |

Calculated Value Definition X

the Calculated Value Definition dialog box. IRELTLES |
Tine units: [N ~ |
Oriy use values

[¥ Greater than or equaltec |10
[ Less than or equal to: 0

[ ok ] coanca | Hep |

Name - any name you wish. For example, “’Calculated fresh
value of food”’.

Formula - enter the formula used to convert each sensor’s
reading into the calculated

value. Symbol What it means
Example: + addition.

The value of fresh food is given - subtraction

as: * multiplication
Fresh Value = (Measured / division
Temperature - Target raise to power
Temperature) * Time ( left bracket
Assume the Target Temperature ) right bracket

is 60°C. sqrt( ) square root

Set the Formulato $ - 60. exp( ) exponential

Set the Time Units to hours. log( ) natural logarithm
Select Greater than or equal to log10( ) base 10 logarithm
option and set limit to 60. abs( ) absolute value
The mathematical operations $ where to put sensor value into the formula

currently supported include:

View Data in a Graph

Open the data either from downloading an iMiniPlus or from a saved file. When the data opens it will
present a List and Summary Report. Go to the View Manager and select the View tab. Then select 2D
graph either Line or Step. The graph will presented like below:
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You can select the Graph

option under the Edit menu
to customize the look of the
2D graph.

| B=Ele Ede fton Window Heb
EHSa |ty RS

a38l arw

Internal (*C]

60.0 4
w0
2004,
0.0+

2004

-40.0

17j03/2005  17)03/2005 17032005 1?}03!2005
8:00 p.m. _1:32: 0

SHIPMENT CARGO Ref 335498FGD

1:2 Lm. 1:36:00 p.m.  1:40:00 p.m. 1
Sensor Name
end e —
b= Iglm Wdow e = I
Copy Cirl+C Serial Number | MIBD268015 -
1" BQ || [ B
Graph... x| [for v, presst EEEE=T
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Graph Options rgl
Dala | Sensors | 2D Graphs | Zoom | Legend | Time Zone | Colouss |
Data Tile:
You can add a title to the top of the graph and place a comment (i ‘mgg.a,,hm,.smhas.,mtempe,,mmg
below.
Sensors
Graph Options g\
Data  Sensors | 2D Graphs | Zoom | Leend | Time Zone | Colous |
Inteinal (-40.0to 650 ‘C)MIBD26G  Line
Style: =
Calour, I -
‘weight - [ Use defauls
Marker ’Tl c 1 Help
Style * -
Siee 2 B
Frequency: |1 Eﬁ
Specilications —
Sle [Showas flsdin. x|
|- S —
| — |
4 IR - —
oK Cocel | ab | Heb |

In the Sensors tab you can customize the look of the graph with various line and color styles. You can
color the graph to show the alarm (specification) limits as shown in this example.

In the left hand side of the box the description of the iMiniPlus data is displayed. If there were more than
one data file was selected through the Multi Trip Synchronization feature, you would see those listed here
as well.

By selecting each sensor description, you can customize how each is displayed on the Multi Link graph.
See Multiple Trip Synchronization Wizard section

ZD Graphs Graph Options g|
Data ] Sensors 20 Graphs ]ZUDITI 1 LegEnd] Time Zunei Culuurs]
Show on Graph
¥ Comment ¥ Horizantal ] Grid
¥ Title W Vertical [v) Grid
m ¥ Readings ToolTip
Select this box if you want to display the comment line on =
Wertical [v] &xis ]FiII to the right _:j
the bottom of the graph
Border Colours JUse default calours Lj
Title Vertical [¥) duis Limits:~ [ctual Fieadings ~|
Select this box if you want to place a title on the top of the
graph.
Readings ToolTip =
et ag default
Select this box if you want the Tooltip box to open next to - o soob [ o]

the mouse cursor on the graph. The box will show the date,
time and reading at any point along the x-axis.

Horizontal (X) Grid

Select this box if you want to display a dashed horizontal grid on the graph.

Vertical (Y) Grid

Select this box if you want to display a dashed vertical grid on the graph.
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Vertical (Y) Axis

This enables you to fill the graph from the left or right or use both sides of the graph.

Border Colors

This enables you to select border colors for your graph.

Vertical (Y) Axis Limits

This enables you to display the graph Y-axis (temperature readings) to fit either the complete range of the
sensor (-40°C to +70°C) or within the alarm limits (if programmed) or from O°C to the actual readings.

Select the Apply button to update the 2D graph.

Zoom

The Zoom feature allows you to manually adjust the
temperature and time co-ordinates to select certain areas of
interest. In this example +30°C and -4°C have been
selected.

%)

Graph Options

Data | Sensors | 2D Graphs Zoom | Legend | Time Zone | Colours |

' @t to ieference | ;l

o=

*C (masimum is 65 *C)

°C {minimuen s 40 °C)

[17/03/2008 1:2800p.=H~] o [17/03/2005 1:55.00 p.= =]

The valid range of values for the x-axis is between 17/03/2005 1:28:00 pm.
and 17/0372005 1:55:00 p.m.. inchusive.

nso m Inter:
L g A >
Description

Serial Number

MIBD268015

0K | cancel | wb | Hep |
Bfe Edt Acton Window Help -=| x|
sdda CHEp A &88U TN
SHIPMENT CARGO Ref 335498FGD il

Internal [°C) .
20.0 4
15.0 4
10.0
5.0 4
0.0 4 .

—_—
17j03f2005  17j03;2005 17j03;2005 17/03/2005 17/03{2005 17/03/2005 17/03/2005

p.m. _ 1:32:00 p.m. 1:36:00 p.m. 1:40:00 1:44:00

| 4

»
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Graph Options r§|
Data | Sensorz | 2D Graphs | Zoom  Legend | Time Zore | Colous |
Pasition of Lagand
Legend %D;Trzu Mame :
W Legend
! Desciiption
| Setial Humies
Ul Product Code
1l start
The legend can be positioned at the top, bottom, left and right of qg::'d“mm
the graph, or omitted altogether. As well as the above Legend ;‘:;ﬁn"nn
L] Sensce Rarge
options, the various Calculated values and/or Custom value can L1 Speciicalion
be displayed. See Analysis in the View Manager section. These
values can be selected or deselected from the Manager while the
2D graph is displayed. .
ok l Cancal Help
Tlme Zone Graph Options r>—<]

In some cases, the configuration time zone will be different from
the time zone at the download location. This allows you to select
which time zone will be used to display dates and times within the
graph and data displays. This option will not have any effect on
the original recorded data.

GMT Time Zone

All times are displayed in Greenwich Mean Time representation

Use daylight time

By selecting the box, the iMiniPlus data will shift +1 hour to
accommodate Daylight Saving Time.

Colors

2D Graphs can be customized to your color preferences.

Data | Sensors | 20 Graphs | Zoom | Legard  Time Zone ]Cdm|

Flease select the lime zone that best represents pour curent location and/or
thee lime zare that pou wark the date and times of readings ieconded by
logpeis bo be displayed in

U1 [GHMT+500) Dsaka, Sappoia, Tokyo -~
1 [GMT+200] Seoul

1 [GMT+300] ¥ akuksk

] [GMT +3 30) Adelade

T |GMT +8 30) Dansin

1 (GMT+10:00) Brisbare

1 [GMT+10:00) Canbera, Melbourne, Spdney

L1 [GMT +10:00) Guazm, Port Moresty

(] [GMT +10:00] Hobast

] [GMT +10:00 Viadwvostok

T (AT +17:00) Magadan, Soloman 1z, Hew Caledonia
5 A, \welirglan

aeeehatk s Mardhall le

[V Uze dagdight lime.

™ Set az default
oK I Cancel Help
Graph Options E|

Data I Sensolsi 20 Glaphsl Zoam | Legend] Time Zore  Colours |

Category:
2D Graphs

Legend
X Gnd
' Gd

Foreacun: [N - | [?mﬂle' T—

Backgound: [T

™ Set as default

o]

Cancel Apply Help
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Beint ZX|
Printing the results e
Staur  Ready .
The print window can be brought up by simply clicking once on the uczim o
" i I~ Pint 1o ke

"Print" icon located on the toolbar or by clicking the "Print..." menu
item from within the File menu.

Print rang=. Copiez

Wmbsr cf copies 1 =

o A
© Pages home [1 b . r =
E L !

Hep Cancel

Sending a file by e-mail direct from Console

You can send files of interest to another person, by e-mail, directly from the software without the need to
exit to your e-mail software or to deal with file attachments.

While you have the file of interest open and being displayed on the screen, just click once on the "Send
Mail" icon located on the foo/bar and your e-mail software will pop up with the file already inserted as an
attachment. Type the desired e-mail address to send the file of interest to, add any message that you wish
to include, and then click "Send".

Clicking the "Send..." menu item within the File menu will achieve the same results as clicking the "Send
Mail" icon as previously described.

Note, the recipient of the file will also need to have a copy of the ConsolePro software to open and view
the file that you sent. ConsolePro software is free and can be downloaded from www.cryopak.com

If you want to attach your data files in file formats other than the ConsolePro format, save the desired file
formats in Save As section of the File menu, and attach to an email through the email software.

Calling up previous results

Open [Z][X]
The files that have most recently opened and displayed are e | L s rEoE
listed towards the bottom of the " Fife" menu. To open other w-ﬁ“ ZE%%E%
files, click the "Open" icon located on the foo/bar, which will N [Slmasan,
display the "Open” file dialog similar to the following picture Doy R
and allows the user to locate and open one or more files of
interest. s

g Compde

Clicking the "Open..." menu item within the File menu will _
achieve the same results as clicking the "Open” icon as Motk s | 1 o
previously described. e e

Digital signatures

Support for digital signatures is primarily provided for compliance with the US FDA 21 CFR Part 11
regulation - Electronic records and electronic signatures. Various industries however, may find inclusion of
digital signatures beneficial towards their quality control and assurance systems.

Digital signatures allow users to include their digital signature within an ConsolePro file along with a
meaning/reason for the inclusion of the digital signature. To add digital signatures to ConsolePro files, a
licensed copy of User Admin software must also be installed. For more information about how to use User
Admin software contact your distributor.

7. Customizing the software
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{5 ESCORT Console Pro 2190
In the "Edit" menu is a command called "Options..." Eile [Edit] Action Help
@ (|l €} IR lAaBS8H laTR
This menu command opens a Window, which will allow the [Vewr  Options.. | - x
many of the features that the software offers to be customized. The following
sections will provide an explanation of each of these options so that users will > General
be able to make the best use of the software. The options that are available > File
for customization are grouped together into the following sections: > Date
» Time
Nearly All of the options available will change the software in real time. For > Time Zone
example, if the language selection and/or the date format are changed, all > 2D Graphs
windows that are open will be updated without the need to restart the software. > Legend
If you make a change which does require ConsolePro to be restarted, you are > Products' ]
informed by an on screen message. »  Communications
All these options are stored on a per user basis. Therefore, if more than one > Languages
user operates on a single workstation the software will allow different > Colors
customization settings for each. » Advanced
General
Dptians X

The General Se.ttlngs options allow you to change varlqus T
preferences that will affect the overall appearance of the information Genesdl | Fie | Date | Time | TimeZone | 20 Graphs | Lepend |

shown by the software. Diplptenpercies v [EETICT |
- - Diakog Testue | B
Display temperatures in  Diplay s S B

X . ) ) . ¥ Display the View Manager
This will determine what units of measurement temperatures will be

displayed in. The options include:

¥ Display Postz and Products

° Fahrenheit (oF) I Display Tip of the D.ay when slarting
e Celsius (°C)
e Kelvin (K)

Dialog Texture
The feature is disabled (3 Cancel Heb

Display the Status Bar

Select this box to display the Status bar and the bottom of the software screen. See Chapter 8 Menus and
Toolbar.

Display the View Manager

Select this box to display the View Manager in the left hand side of the screen. See section called View
Manager.

Display Ports and Products

Select this box to display the available communications ports and list of loggers that need to be selected.
See section Getting an iMiniPlus ready for logging.

Display Tip of the Day when starting

Select this box if you want to display a Tip of the Day box when ConsolePro is first opened. This can be
particularly useful for new users of ConsolePro software.
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File

Recently used file list

This determines how many of the most recently accessed files
are listed in the " File" menu for quick access to be opened and
viewed again. Once this nhumber of files has been reached, the
reference to the oldest file opened will be removed and the
most recently opened file will be added to position 1. Only the
file reference is removed from this list, the actual file is not
deleted. Changing this setting will take effect the next time
ConsolePro is started.

Default Folder

This determines the location where the files are stored. The
location defined here can specify a local drive path or a network

Options rgl

Products | Commurications | Lenguages | Colows | Advanced |
Generdl  File | Date | Time | TimeZone | 20 Graphs | Legend |

¥ Recentyusedfelst  [3 =] entiies

Defauk Folder

|CAD ocuments and Settings'Lisa & John'My Documents\My Logger _..|

[k ] cace | ey | Hep |

drive path. UNC folder names are supported. The button at the end of the edit control will assist you to
locate the default store folder by browsing the folder structure available to you, if you choose to use it.
Since this is the default location where files are stored, this also represents the default folder that will be
used when searching for files to open (through the Open command in the File menu). The default location

is “..\My Documents\My Logger Data”.

Date

Options [fl
The Date setting allows how the date information can be .;T::h] Flibm"'éfb']'g,i!,ewzﬂl ri;":,ai,nmi
displayed by the ConsolePro software. It does not affect how
the date information is stored and therefore, how the date £48hot Do
information is shown can be changed at any time. Within this #loians
option window, a sample of the date using the formats £)Cunon
selected will be displayed. |
Date separatos; l—;|

To customize how the date information is displayed, the
following elements may be used. If spaces are used to e
separate the elements, these spaces will appear in the same
location in the date displayed. The letters must be in
uppercase or lowercase as shown in the following table (for
example, "MM" not "mm"). Characters that are enclosed in
single quotation marks will appear in the same location and ot ] coen e
unchanged in the date displayed.

Element Meaning

d Day of month as digits with no leading zero for single-digit days.

dd Day of month as digits with leading zero for single-digit days.

ddd Day of week as a three-letter abbreviation.

dddd Day of week as its full name.

M Month as digits with no leading zero for single-digit months.

MM Month as digits with leading zero for single-digit months.

MMM Month as a three-letter abbreviation.

MMMM Month as its full name.

y Year as last two digits, but with no leading zero for years less than 10.

vy Year as last two digits, but with leading zero for years less than 10.

yyyy Year represented by full four digits.
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Time

To customize how the time information is displayed, the following

= Diefak
elements may be used. If spaces are used to separate the elements, .
these spaces will appear in the same location in the time displayed. The [
letters must be in uppercase or lowercase as shown in the following —

table (for example, "ss", not "SS"). Characters that are enclosed in
single quotation marks will appear in the same location and unchanged

in the time displayed.

I

Options

Podacts | Commwricsliors | Larguages | Colous | Advanced
General | Fie | Date  Time | TmeZone | 20 Guagke | Legend

Ok | Comcel | Apw | Hen

Element Meaning

h Hours with no leading zero for single-digit hours; 12-hour clock.
hh Hours with leading zero for single-digit hours; 12-hour clock.

H Hours with no leading zero for single-digit hours; 2L4-hour clock.
HH Hours with leading zero for single-digit hours; 2L-hour clock.

m Minutes with no leading zero for single-digit minutes.

mm Minutes with leading zero for single-digit minutes.

S Seconds with no leading zero for single-digit seconds.

SS Seconds with leading zero for single-digit seconds.

t One character time-marker string, such as A or P.

tt Multi character time-marker string, such as AM or PM.

Time zones

In some cases, the configuration time zone will be different from the time zone at the download location.
This allows you to select which time zone will be used to display dates and times within the graph and data
displays. This option will not have any effect on the original recorded data.

GMT Time Zone

All times are displayed in Greenwich Mean Time representation

Use daylight time

By selecting the box, the iMiniPlus data will shift +1 hour to
accommodate Daylight Saving Time.

2D Graphs

Options rz

Products | Commurications | Languages | Colows | Advanced |
General | Fie | Date | Time  TimeZone | 20 Graphe | Legend
Pleaz salect the time zone that best represants pour cument location and/or

the lime zone thal pou wanil the date and bimes of ieadings iecoeded by
laggets o be displaped in

1 (GMT+9.00) Osaka, Sapparo, Takyo ~
T (GMT+8:00] Seoul

T (GMT+3:00) Y akutsk

U1 [GMT+8:30) Adelside

1 [GMT+3:30) Darwin

1 (EMT+10:00) Biishane

1 [GMT+10:00 Canbesra, Metbourne, Sydney

T (GMT+10:00] Gusarn, Port Maresty

1 [EMT+10:00) Hebart

1 GMT+10:00) Viadivostak

1 (GMT+11:00) Magadan, Soioman lz., New Caledonia
¥ [GMT-+12:00) duckland, Welinglon

T ST L1200 Fai K amnchabies Moacchall 1z

[~ Use dayigh lime

0K I Cancel Apply Help
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Comment Options 3

Select this box if you want to display the comment line on ::xﬁ lkwi'"::: iTsT-,Le LTQ:.:;L E°2'[°,“.§,alhf'|j"f:’f:d I

the bottom of the graph ——

H [ Comment v Horizontal (<) Grid

Tl—tle I~ Tite W Vetical (¥) Giid

Select this box if you want to place a title on the top of the W Readings ToolTip

graph. Wertical (1) Auis [Use bath sides of araph =

Readin S TOOITi : Border Colows |Donotuseaml L[
Wertical [¥) Axiz Limits: | Full Sensor Range L[

Select this box if you want the Tooltip box to open next to

the mouse cursor on the graph. The box will show the

date, time and reading at any point along the x-axis.

Horizontal (X) Grid

Sglect this box if you want to display a dashed horizontal ok | coce o 1o

grid on the graph.

Vertical (Y) Grid

Select this box if you want to display a dashed vertical grid on the graph.

Vertical (Y) Axis

This enables you to fill the graph from the left or right or use both sides of the graph.

Border Colors

This enables you to select border colors for your graph.

Vertical (Y) Axis Limits

This enables you to display the graph Y-axis (temperature readings) to fit either the complete range of the
sensor (-40°C to +70°C) or within the alarm limits (if programmed) or from O°C to the actual readings.
Select the Apply button to update the 2D graph.

For more information about how to create and customize graphs, see section View Data in a Graph

Legend
Options rZL
Each graph generated has a legend that information can Products | Communications | Lenguages | Colows | Advanced |
General | Fie | Date | Time | TimeZone | 20 Graphs Legend
be added to.
Posiion of Legend [Bottom of graph =l
The legend can be positioned at the top, bottom, left and %;ms . |
. . Ensor Name
right of the graph. Or omitted altogether. As well as the ¥ Legend
above Legend options, the various Calculated values S'[;“W[":“D
. L. esciphion

and/or Custom value can be displayed. See Analysis in ] Serial Number
the View Manager section. These values can be selected S:‘:ﬁ“‘“”"e
or deselected from the Manager while the 2D graph is [ Finish
d iSpIayed . 13::::; Name Intetnal H 5::::"“ zone

Descriplion ] Sensor Range

Serial Numb MIBDZE8015 .

Product Colt— TMANDEL L Specification

Start ATOB{2004 2:39:00 p.m.

Finizh 50872004 11:29:00 a.m.

Current time zone | [GMT+12:00) Daylight time |

i 0.

Sc:sulRangc

Specification

Sovel

-ﬁg:::‘e 0K I Cancel Help

Lowest

PHI Acrobic
PHI bi
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Options [zl
PI‘OdUCtS Geneel | File | Dabe | Time | TaneZone | 20 Graghs | Legend |
Products | Commurications | Lagusges | Cobuws | Advanced |
Because ConsolePro supports other logger models, you can select ﬂWsmnmm
L ESCORT ChanReader - Jurion/iLs
the appropriate type. Make sure the box called iMiniPlus is ticked, € ESCORT duricr ”
. . . |¢# ESCORT ChantFieade - Mini 2000Arkeligent
otherwise the software will not be able to find the logger (= EsCoRT sri 2000
[I[SESCORT Inteligert aireless Mini
|{EHESCORT iLog ﬂ
H . . . |$¥ ESCORT REDI
By using the arrow buttons down the right of the box, the priority of
the model can be set. This may be important when more than one =
logger type is used and may speed up the communication of the
model selected.
Communications T e e
— . Options X
You need to select the correct communication port that is connected ) ) —
Genewod | Fie | Date | Time | TimeZome | 20 Graphs | Legend |

Products

Commmunications

| Langusges | Cobour | dvanced |

to the iMiniPlus. The box above displays all the ports available to be
used within Console. Please make sure that if a USB adaptor is used
it is connected BEFORE you start Console, otherwise it will not show
in the list. If more than one port is displayed and you are unsure which
is the one connected to the iMiniPlus, tick one and then select the
Download or Program and Configure Wizard. If the iMiniPlus doesn’t
communicate with the software then select another port until you are
successful.

If a USB adaptor has been used but removed, ConsolePro Software
will default to COM1. If this cannot be used, you must close the
software, reconnect the USB adaptor (COM5 shown above) and
restart ConsolePro again.

o

Carcel |

ESCORT Console

N

Note: If no Com Port is
available, you cannot

The COM port usually used by ESCORT Consola is ot available or used by another device, ESCORT Consobs has selected the serial poet for
communication with products bo COML,

To charge your preferred COM port, plaase go bo the "Edt” menu, choose the "Options™ command and select the "Communications” tab.

communicate with a logger, but

It i Faster to use the “Parts and Products” window if it is open,

you can view data files.

Languages

Options

X]

Genesal ] Fie
Products | Communications

| Date | Time | TimeZone | 2D Giaphs | Legend |
Longuages | Colows | Advanced |

[ ETI——— -

[Ergiich (New Zeatand] =l

Language to display

Language for printing:
ConsolePro has multi language support. If a change is made it
will not take effect unless ConsolePro has been restarted.

The changes that have been made wil not take effect untl ESCORT
Conzole has been restated

Carecal

Hpply Help
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Colors

2D Graphs and List Reports can be customized to your color ¥ Gid

preferences.

General | File | Date | Time | TimeZone | 20 Giaphs | Legend |
Products | Commuricafions | Languages  Colaws | Advanced |

Category

2D Graphs |
Comment
Legend

*r Grid

List Repart
Detault test calaur
Reading above calbiation

Reading below caibration
Rleading below specification
Reading has comment attached i
Fleading was below dewpaint
Reading was interpolsted

| AaBhCCY
ok oount —j SBbCCHyZe
I I Help

Advanced

The Advanced tab in Options enables you to select or deselect [ S| |ode | Time | TimeZone | 20 Gioghs | Logend |
certain parts of the ConsolePro software program. See descriptions

below.

These options not apply to iMiniPlus:

Automatically expand list of sensors(s) when grouping them

Calculate and display interpolated readings

Configure multibit settings as part of sensor configuration wizard
Remind users of consequences of upgrading the data format of

loggers and ChartReaders
Show connection reminder for scanning loggers

Users must supply password for each logger and ChartReader as

required

Options |Z|

Products | Commusnicatiors: | Languages: | Colours  Advanced

han grouping them

[ Calculate a

[ Configure mulibst seltrigs a2 part of senso conliguration wizaid

[ Aemind users of ol upgrading the dats format of loggers
[l Showe ion reminder for leggers and ChaitFleade:
[l Sho ion reminder for irg loggers and ChatReades

[¥] Show connection reminder for restaiting loggers and Chaitfieader:

(¥ Shaw connection reminder o scanning loggers

(] Shawei i hiarisng dala I altiple logger lips
[ Users must supply passward far each logger and Chatfleader as requitc

[[ok ] cencel | sy | Heb

Show connection reminder for downloading loggers and ChartReaders

This description box appears at the start of the download

wizard and can either be selected or disabled through the
Advanced tab or disabled by ticking the “Do not remind me
of this again” box at the bottom.

el the ESCORT dowrload readings wizard.
This wizeed wil guide you thicugh the process of downloading the
teadirgs ficen ESCORT products o viewing and analysis. Pleass dick
Heut when pou are ready to procesd,

Fisady | Sesrch |

Thiz wil setrieve nformation fom kaggers and/oe ChartReaders thicugh the communication part{s] o
allovs you lo ety Ihe rmadings Ihal have been racorded by lhe loggers.

Flease ensure all loggers are i
compuracalion poil[z) of bis compute.

and/or CharlReadsrs are ak th

Prass Mext when ready Lo proceed

™ Do ral remind me of 1his again

Cancel | [ Heat> Help
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Show connection reminder for programming loggers and ChartReaders
This description box appears at the start of the program and

configuration wizard and can either be selected or disabled through T i e s e
the Advanced tab or disabled by ticking the “Do not remind me of
this again” box at the bottom. P | semen]

Tris il f srfiu Ch " "
i yous 83 coribgnars the vaiku ibngs

P al loggers s in an intef: Chatfiaaces are ak the
camnurizaiion paris) o s conpule:

Preaz Hewt when readr 1o procssd

T D ot v v of s g

[l ] I

Show connection reminder for restarting loggers and ChartReaders

This description box appears at the start of the Restart wizard and
can either be selected or disabled through the Advanced tab or T g e st e ST
disabled by ticking the “Do not remind me of this again” box at the ST e
bottom. e e
Thiz wall loggers that have b before. Frog i h ious log i
vl e e I i e g i,
P allloggens e nan i th ication port{z) of this computer.
Press Mest when isady to proceed
™ D rool servind o of Fas again
Corvel | m=n Hel

Show introduction when synchronizing data from multi logger trips

Multiple Trip Synehronisation

This description box appears at the start of the Multi Trip

ek [ o o

Synchronization wizard and can either be selected or disabled e e Lo e L
through the Advanced tab or disabled by ticking the “Do not remind
me of this again” box at the bottom. R | Synchaone |

This 1 thiough the steg hiceiae ip data o miple loggers.
which may have bee bagged e dileeedt lime peiods andfor dilerent logong nlervals 1ol the
data czn be viswwed side by side 01 b viewsed] oyedaid.

By suppating dilessrd lime pesod spnchvoneshion, compaalie of conlruous anskss: can b
pesiomed.

For esanmpls. i cheas A s
week i#th ooged daing ih

. With contiruous i
& similat ime period and where each logoer

logged i it v Lrigus locaion
Press Mest wihen ieady to procesd.

™ Dot iemind me of tis gain

Carval Hest » Hep |

8. Menus and Toolbars

At the top of the screen for the ConsolePro software, just below the title bar, which contains the name of the
software, is the menu system and toolbar for the software. The toolbar provides quick access to some of the
more commonly used functions within the menu system. The menu system contains lists of all the operations
and commands that are available to you while using the software.

Title bar
Menu bar
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=m0

ESCORT Console Pro 2.12.07 <
- File Edit Action Help Toolbar

A

Status bar

U For Help, press F1

Menu commands

The menu system has been separated into groups of related commands. Each of these menu groups is
explained in more depth in the subsequent sections. The software will only display the menu groups and
commands within each menu group that are appropriate depending on what you are currently doing with the
software.

You may also see that some of the menu commands have a reference after the command name, for example
Ctrl+O. These represent key strokes on the keyboard that instruct the software to perform the appropriate
command, without out the need to select the menu or toolbar command. For example to cause the command
to be performed you must press and hold down the first key mentioned while pressing the other key once.
When letters are used in the key reference, for example Ctrl+O, it does not matter whether or not the caps
lock is on or off.

File Menu
) . e . Eiel Edt Action Window Hel
The "File” menu contains commands that generally relate to an iMiniPlus file as a whole. | .. =
An iMiniPlus file contains a variety of information that relates to a data set representing Jose
. . . . . R . el Save Chri+s
readings that were recorded over a discrete period of time by a single iMiniPlus. The File Y
menu will appear similar to the following picture. & pin... ke
Prinit Prayiew
Paint Satup...
Liser ]
The following table outlines the commands and the explanation of each command that = mm
may appear in the "File" menu when using the ConsolePro software: B Oigtally Sion..

1 0519-0097-00045
2 MIEF033545-0025 EWT
3 0519-0097-0004

4 (HE2-0358-0003

S (M22-0353-0002

£ 0422-(1353-0001

710U May_2007

& ICU_Part_Marth_Jund?
2 10U May 2007

Exit

Command Explanation

This will display the Open file dialog, which will allow you to open iMiniPlus
Open... ( ) files that contain readings previously retrieved and saved as “Logger
Compact File (.Icf)” format
It will start at the folder defined in the Default Folder settings section in
File under Options.
Close This command will close all windows that are displaying information about
the open file that is currently selected. If no files are currently open this
command will not be visible.

This will save any changes you have made to the iMiniPlus file to your disk
Save ( ) drive.
Save As... This will display the Save As file dialog, which will allow you to save a copy

of the file currently being displayed in the same or different folder with the
same or different file name.

] This will open a window allowing you to print a copy of the iMiniPlus file to
Print... ( ) an output device, which will typically be a printer. This command is further
explained in the section " Printing the results”.
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Print Preview

This will change the display mode of the software to show you a copy of
how a printout of the currently selected file and window would look like. In
"Print Preview" mode you will not be able to zoom in or out of a graph.
Click “Close” to exit the "Print Preview" mode and return to normal display
mode.

Print Setup... This will open a window allowing you to view and/or adjust one or more of
your printer's settings.
User When User Admin software is installed, users must logon to the software

prior to being permitted to use the software. When User Admin software is
not installed this feature will be greyed out.

L 6

Log On (

This allows a user to logon to and use the ConsolePro software. Therefore,
this command will only be available if the ConsolePro software is connected
to the User Admin software. If a user is already logged on to the software,
then this command is not visible.

£

Log Off

)

This allows the currently logged on user to logoff the ConsolePro software.
If there is no currently logged on user, this command is not visible.

Change Details...

This allows the currently logged on user to modify their password that they
use to logon to the ConsolePro software. This command will only be
available if User Admin software is installed and the User Admin
administrator has granted the appropriate user permissions.

Send... ()

This will help you send, by email, the currently open and selected file to
another user without the need to exit to your email software or to deal with
file attachments. This command is explained in further detail in the section
"Sending a file by email direct from Console".

Properties...

This will open a window that will display the information about the file that is
being displayed and currently selected. This same window and information
will be displayed if you view the properties of the file from Microsoft
Windows Explorer.

Digital Sign... ()

This will open a window to display a list of digital signatures that have been
included with the file. It also allows you to add and print this list of digital
signatures. This command is explained in further detail in the section

" Digital signatures”.

1, 2, 3, etc

This portion of the menu represents a list of the most recently files you
have viewed. To reopen one of these files, simply click on the entry (name
of the file) to open. If a file that you want to view is not included in this list,
you may use the "Open..." command included in this menu. The number of
files included in this list can be adjusted through the "File" section of the
Options.

Exit

This command will exit and close down the ConsolePro software. Any files
that you currently have open will also be closed automatically for you. If a
user is currently logged on to the ConsolePro software when the
ConsolePro closes, the user will be automatically logged off. F you have
downloaded data from a logger and not saved it, you are prompted whether
to save it or not.

Edit Menu

The "Edit" menu contains commands that generally relate to the contents [ Fie ;dtl Action Window Help

of an iMiniPlus file and will appear similar to the following picture.
The following table outlines the commands and the explanation of each

B
= ﬂ Copy  CtrHC

command that may appear in the "Edit" menu when using the ConsolePro Report... d

software:

Options. ..
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Command

Explanation

Copy ()

Places a copy of the contents of the currently displayed window onto the
clipboard, which can then be pasted into any Windows® application. If you are
copying a graph, the graph at its current zoom range is copied to the clipboard. If
you are copying from one of the tabular style windows (Readings or Summary),
then the entire contents of the window are copied to the clipboard, regardless of
what part of the data you have scrolled to view.

This opens a box called List Report Options. This allows you to select the date

Report...
P and time range you want to view. This feature is visible only when a Readings
data file is opened in Console.
This opens a box called Graph Options. This allows you to customize the look of
Graph... . T ’ )
the graph. This feature is visible only when a Graph is opened in Console.
Options This will open a window allowing you to customize the software. This command is

further explained in the chapter " Customizing the software" .
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Action Menu

The "Action” menu contains commands that generally relate to the & &l ¢ & Restart...

usage and interaction with loggers.

The following table outlines the commands and the explanation of
each command that may appear in the "Action” menu when using

the ConsolePro software:

File Edit |Action I Help

& Program and Configure...
&% Download Information...

L8 show Current Readings...

Command

Explanation

Restart ()

This will display a wizard that will help you to restart an
iMiniPlus that has been programmed before, using the
previous settings for the new log trip.

Program and Configure...()

This will display a wizard to help you through the necessary
steps to prepare the iMiniPlus for its next use. This command
is explained in further detail in the chapter " Preparing
iMiniPlus for use".

Download Information... ()

This will display a wizard to help you through the necessary
steps to retrieve a copy of the recorded readings stored within
the Escort(s). This command is explained in further detail in
the chapter " Results from iMiniPlus" .

Show Current Readings... ()

This feature is not available for the iMiniPlus.

Window Menu
n " Fle Edit Action |Window | Help
The "Window" menu contains commands that relate to the management of e PR

each Window open within the ConsolePro software that displays the contents st

of an iMiniPlus file.

Index Cogse

Clase &1

Serial Num 0o

. . . Hw versic Tile Hort
The following table outlines the commands and the explanation of each Trip No| e vertcaly
command that may appear in the "Window" menu when using the ConsolePro Descriptia  &ranoe Ieons

software: | Battery [] 10515-0097-00045
Command Explanation

New Window

Opens a new window that contains a copy of the information of
the currently selected window.

Split Use this command to split the active window into panes. You
may then use the mouse or the keyboard arrows to move the
splitter bars. When you are finished, press the mouse button or
enter to leave the splitter bars in their new location.

Unsplit Removes the split panes.

Close Closes the currently selected window within the ConsolePro
software.

Close All Closes all the windows within the ConsolePro software.

Cascade Arrange all the windows within the ConsolePro software in an

overlapping style.

Title Horizontally

Arrange all the windows within the ConsolePro software as
horizontal non-overlapping tiles.

Title Vertically

Arrange all the windows within the ConsolePro software as
vertical non-overlapping tiles.

Arrange Icons

Arrange all the minimized windows within the ConsolePro
software at the bottom of the main window.




1, 2, 3, etc The tick mark beside these entries indicates the window that is
currently selected. If you want to change the currently selected
window to one of the windows listed, just click/select the
appropriate entry on this list.

Help Menu

The "Help" menu contains commands that relate to providing you

with help and assistance with using the ConsolePro software. Bo Bk acin jind [iip]

ER&Ea|0 6 Heles
. . . = Tip of the Day...
The following table outlines the commands and the explanation of ¥ 0519.0097-00045
each command that may appear in the "Help" menu when using Index Check for new version...
the ConsolePro software: Orine
Serial Number @ About ESCORT Console...
Command Explanation
Help Topics Opens a window that contains the online help.
Tip of the Day... Displays a number of helpful suggestions about using the ConsolePro

software. This can be enabled at the software startup. See the “General” tab
of “Options”.

License Not required - No longer available

Check for new This is a simple way of checking to see if there is a newer version of this

version... software available for download. This command is explained in further detail
in the chapter " Getting updated software".

Online... This will open your default Internet browser software and display

www.cryoapk.com This command requires that your computer be currently
connected to the Internet to successfully display the website.

About Display the version information about the ConsolePro software that you are
Console... () using.

Toolbar commands

Each picture on the toolbar represents a unique command. The pictures that are included on the toolbar
represent the following commands:

This will display the file open window to allow you to locate and open iMiniPlus files that
contain previously retrieved readings.

Save a copy of the iMiniPlus data to a file on your disk drive.

Opens the window that will allow you to print a copy of the iMiniPlus data to a printer.

Creates a new blank email for sending a copy of the currently selected open file as an
attachment to a recipient of your choice.

This will log a user onto the ConsolePro software provided User Admin software is also
installed.

This will log the user off the ConsolePro software provided User Admin software is also
installed.

Displays information about any digital signatures included in the currently selected open file,
which is also allows where new digital signatures can be added to the file and where you can
print a copy of the digital signatures.

Places a copy of the currently displayed information to the Windows clipboard so that you can
paste it into another Windows software package.

B = BEE D E

Zooms out one level of the actively displayed graph. If you are displaying a graph and this
function is not available, then all data that is available to be displayed is currently been
displayed and therefore there is no more additional information that can be displayed by
zooming out.
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logged trip.

Opens Restart Wizard that reprograms iMiniPlus using previous logging settings for new

Opens Program and Configure Wizard to help you through the necessary steps to prepare the
iMiniPlus for its next use. This command is explained in further detail in the chapter
" Preparing iMiniPlus for use”

Opens Download Information Wizard to help you through the necessary steps to retrieve a
copy of the recorded readings stored within the Escort(s). This command is explained in
further detail in the chapter " Results from iMiniPlus" .

This feature is not available for the iMiniPlus.

Opens your default Internet browser software and display www.cryopak.com

Displays the version information about the ConsolePro software that you are using.

BEEE B ® e

This will allow you to show the help topic on any particular command or topic that you
subsequently select.

Status bar

The status bar is a handy one line instruction of a menu activity or shows the graph co-ordinates. It is
displayed at the bottom left of the ConsolePro window.
To hide or display the Status Bar, choose Options from the Edit menu and uncheck or check Display the
Status Bar option from the General tab.

Description of the Menu activity. When a menu item is selected the appropriate description will appear in

the Status Bar.

<

Send the active document through electronic mail

>

T T T T i

- 1 1
5 | o0:00:20] 3706/2008| 9:15:42 p.m.|

Nl
A——

Displays the date, time and temperature along the x-axis when a 2D graph is displayed.

<

3/06/2008 9:17:57 p.m.; Internal 13.5°C

Sensor Range

-40.0 to 70.0 °C

Specification

10.0 to 25.0 °C

i I KT
A——

See sections 2D graphs and View Data in Graph.

Print preview toolbar

The print preview feature,

available
through the File menu, of the software
will display copy of the data as it would
be included on a print out. When the
software is displaying a file in print
preview mode, an additional toolbar will
appear, similar to the following picture.

Print... | Mext F'age[

EE Eile Edt Action Window Help

& 06 BOA &S5&6U

[ _[woF'age| Zoom |n |

=12 x|

Q2w
|

Close

Command

Explanation

Print...

This will open a window allowing you to print a copy of the iMiniPlus
file to an output device, which will typically be a printer. This
command is further explained in the section " Printing the results”.
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Next Page

This will display the next page included in the print out. This button
will be disabled if there are no more pages available to be
displayed.

Prev Page

This will display the previous page included in the print out. This
button will be disabled if there are no previous pages available to be
displayed.

One Page

Selecting this button will change the display so that only one page
is displayed at a time. Once this button is selected it will change to
"Two Page".

Two Page

Selecting this button will change the display so that two consecutive
pages are displayed side by side at the same time. This button will
be disabled if there is only one page in the print out, like a graph.
Once this button is selected it will change to "One Page".

Zoom In

This will zoom in the display of the print out making it appear larger
on the screen. It will not affect what information is included in the
print out.

Zoom Out

This will zoom out the display of the print out making it appear
smaller on the screen. It will not affect what information is included
in the print out.

Close

This will close the print preview mode of display and make the
display revert to normal mode, which will allow users to switch
between graph display and data listing display, for example.

9. Working with Networks

When using and deploying software in a network environment, network administrators often require
additional technical information about the software so they can integrate support for it correctly and
seamlessly. Contact your distributor or Cryopak Verification Technologies for further information.

10.

Getting more information

Getting updated software

There will be no further updates in ConsolePro software. The last final version 2.12.07.

Finding your software version

Within the " Help" menu, is the "About Console..." command,
which will display a Window similar to the following picture.

Within this window, amongst other information, the full version
number of the software being used is displayed. This information
is useful, for example, to determine if the same software version
is installed on multiple computers and/or if the manual being
referenced refers to the version of software being used.

11. Warranty

s —
About ESCORT c«:_pmi =5
Ezcort Conzole A
Copyright (=) 1995-2010, Escot Data Loggers Ihc
Al rights reserved
“Wersion |nformation:
I
Escort Consale, Yersion 2.12.07
E scort Communications Librane, Wersion 2.18.10
Contact Information:
Escort Data Loggers Inc
F.0. Box 308, Buchanan, Va4 24066, United States
Fhone:  +1 540 254 1433
Fax: +1540 254 2433
E-Mail:  support@escondataloggers. com
Internet  http: v ezcortdls. com |

The iMiniPlus has a 24 months warranty valid from date of purchase. In the event of a malfunction please
contact your distributor. The warranty has the following exclusions:

1. If the unit has been modified from manufacturer’s specifications.

2. Exposure of the logger to temperatures less than -4O°C or greater than 70°C.
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Loss of unit.

NowFEw

Loss or damage caused by the ingress of moisture.
Evidence that the printed circuit board has been removed or tampered with.
Evidence of mistreatment or abuse.

Batteries are not covered by this warranty.

12, Dry Ice iMiniPlus

Important Notes:

1. Do not place the logger inside the dry ice temperatures, use external probe instead
2. Battery of iMiniPlus is not able to withstand temperatures below -40°C
3. Do not crush or cut the external probe

Specifications

Description

Product Code

Specifications

MP-OE-N-8-L (Multi use External sensor)

MP-ST-N-8-L (Single use External sensor)

Memory Options

8K; 8032 readings

Program Interval
Time Accuracy

5 seconds to 18 hours
+1 minute per month

Sensors
Temperature Range

Temperature Accuracy

External

-100 °C to +L40 °C (-148 °F to +104 °F)

11.0 °C (-100 °C to -80 °C), £1.8 °F (-148 °F to -112 °F)
+0.7 °C (-50 °C to +40O °C), #1.3 °F (-112 °F to -58 °F)
+0.6 °C (-50 °C to +40 °C), #1.0 °F (-58 °F to +10L °F)

Resolution

0.1°C (0.1 °F)

Sensor Response Time

External Sensor — T90 of 5 minutes in moving air

LCD Operating Range

-20 °C to +70 °C (-4 °F to +158 °F)

Alarm Thresholds Two
Alarm Configuration High & low
Bookmark Yes

Preprogram Option

User Programmable
Preprogram also available

Start Option Push button and/or timer
Start Delay Yes
Stop Option Yes, Stop button (can be disabled)
Size 83 x 57 x 17mm (excluding lug)
Weight 70 grams (including battery)
Case Material Polycarbonate /ABS
Battery 3.0V, user replaceable
IP Rating IP65 (with plastic cap over USB connector)
24 months, excluding battery (Multi use loggers)
Warranty . . .
One Trip, excluding battery (Single use loggers)
Calibration Upon request

Accuracy Certificate

Yes

Other Certification

ISO9001:2008, CE, RoHS, EN12830

Battery Life

1-2 years (depending on usage)

Interface

USB (included)

Software

Console Pro
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PDF & LRF

TXT, CSV, SYLK & LCF
Password protected (programmable using Console Pro Software)
encrypted binary file is generated along with PDF

Default File Format
Data Export

Security

13. Appendix

Troubleshooting

Problem

Solution

My iMiniPlus appears to be “dead”. There
are no readings on the LCD.

Change the battery using a CR2450
(3V Lithium coin cell.)

The Stop button is not working

Reprogram the iMiniPlus and tick the Enable Stop button
box in the Startup tab of Program and Configure. See
section Setting the Start and logging duration or Quick
Start Guide section. Note this defaults back to unselected
at the next program

The iMiniPlus appears to be working but |
cannot program it. Software displays error
“ The software was unable to find any
products that it supports....”

Make sure you have tried all the solutions the Wizard has
suggested.

Check you have the current version of ConsolePro
software

If it still does not communicate you will need to return it
to your distributor for service.

My iMiniPlus is reading -40°C / 70°C
/-100°C /+L0O°C all the time.

The sensor has become damaged. Send the iMiniPlus to
your distributor for service.

The year, date and time on the
downloaded data is incorrect.

The battery has been removed from the iMiniPlus for
more than 30 seconds. Re-program the iMiniPlus and
select the PC clock in the Date/Time tab of Program and
Configure. See section Checking the time clock.

When | press the Start button to start my
iMiniPlus it displays some readings then
displays “Stopped”

You have to re-program the iMiniPlus to enable the Start
button to initiate another logging cycle. See Program and
Configure section

Changing the Battery

The iMiniPlus displays battery low symbol on LCD display once battery
voltage falls below 2.8V. The iMiniPlus checks the battery status every
10minutes or when it is interrogated by software i.e. downloading or program
and configure.

To change the battery, turn the iMiniPlus over and unscrew the battery cover
on the back with a coin. Remove the old battery and exchange for a fresh
one. Be careful not to damage the plastic thread on the inside of the battery
compartment when removing the old battery, otherwise the battery cover may
not fit securely back and in turn may allow moisture to enter the logger.

Sorial Wumber IH-B1.164.011
Product Code: MPIN-D-8.L

|
Battery -
compartment

Note, if the battery is removed for a period of longer than 30 secs, the
internal clock will need adjustment back to the present data and time. This
is done through the Program and Configure Wizard. See section Checking
the time clock.




Contact details 65

14. Contact details

If you require further information regarding CRYOPAK Verification Technologies, Inc.
products please contact us at:

USA
Mailing Address: PO Box 309, Buchanan, VA 24066
Office: 120 Parkway Drive, Buchanan, VA 24066
Phone: +1-540-254-1433
+1-732-346-9200 Ext. 150
Fax: +1-540-254-2433
Email: techsupport@cryopak.com
CANADA )
Phone: +1-514-324-4720
I * I +1-514-773-5966
Fax: +1-514-324-9623
Email: support@cryopak.com
A
FRANCE
Address: TCP Cryopak France

1 Rue Berthelot
Z.l. La Maine
76150 Maromme

Phone: +33232825965
Email: techsupport@cryopak.com

You can find additional information regarding all of our products on our website:

www.cryopak.com
http://www.cryopak.com/en/verification-products/
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